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Purpose 

The purpose of this course is to give comprehensive instruction on the use 
and features of the Calendar in Outlook XP.  This course will cover 
introductory topics through advanced topics. 
 
 

Prerequisite 

Students taking this course should have a basic working knowledge of 
sending and receiving e-mails using Outlook XP.  The Outlook XP 
Introduction course is recommended but not required. 
 
 

Course Objectives 

In this course, students will learn to: 
 

• Understand the components of the calendar interface 
 

• Create, edit, and delete appointments 
 

• Create, edit, and delete events 
 

• Schedule, respond to, update and cancel meetings 
 

• Use color to organize a calendar 
 

• Utilize group schedules to track other users’ calendars 
 

• Grant access to and share a calendar with other users 
 

• Print a variety of calendar styles 
 

• Customize the calendar interface and options 
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Chapter 1 
Understanding Calendar Basics 

 

 
Chapter Objectives: 

•  Understanding the Calendar Window 

•  Opening and Selecting Calendar Items 

•  Understand Calendar Item Definitions 

•  Working with the Calendar Toolbar 

•  Using the Date Navigator 

•  Accessing Calendar Views 

•  Using the Day View 

•  Using the Work Week View 

•  Using the Week View 

•  Using the Month View 

•  Accessing Other Calendar Views 

•  Using the Preview Pane 

•  Using the Reminders Window 

•  Changing the Time Bar 

•  Creating Other Calendar Folders 
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Overview 

Outlook’s Calendar allows for easy input of appointments, meetings, and 
events.  Alarms or reminders can be set for these items to automatically 
alert the user with sounds and pop-up menus.  The calendar also 
simplifies group scheduling by prompting users to send meeting requests 
and automating replies. 
 
This chapter contains the basic information and procedures for 
understanding the various parts of the calendar window and terminology, 
using different calendar views, and creating additional calendars. 
 

Understanding the Calendar Window 

The Calendar window is made up of three primary areas that serve 
different purposes.  They are the calendar notepad, Date Navigator, and 
the TaskPad (which is actually part of Outlook Tasks). 
 
The following example describes the various parts of this window: 
 

 
 

Calendar 
notepad area 
with time slots 

Date 
Navigator

TaskPad 
Time bar 

Banner 

Divider 
bars
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The amount of space the Date Navigator and/or the TaskPad take up in 
the Outlook interface can be controlled by dragging the gray divider bars. 
 

 
Procedure: 

1.    Place the mouse over a divider bar until the sizing arrow displays. 

2.  Drag the divider to change the size of the area. 
 

 
Tip: 

•  The Date Navigator and/or the TaskPad can be made to disappear by 
dragging the divider all the way to an edge of the Outlook window.  For 
instance, dragging the gray divider all the way down will make the 
TaskPad disappear.  To restore any section, grab the divider bar at the 
edge and drag it back to its original location. 

 

 
Warning: 

•  When attempting to drag the horizontal divider bar, be careful not to 
grab any of the TaskPad fields by mistake, as these can also be 
dragged and removed. 

 

 
 

Drag here … 

… NOT here 
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Opening and Selecting Calendar Items 

Two terms that will be used extensively in this manual are Select and 
Open.  While there is keyboard navigation available for the calendar, the 
graphical nature of the calendar makes it more convenient to use the 
mouse. 
 
The following procedures describe the best methods for selecting and 
opening calendar items using the mouse as called for in this manual. 
 

 
Procedure: (To select a calendar item) 

1.  Place the mouse on the left blue border of the item.  The mouse pointer 
will change to a four-headed arrow. 

 

 

2.  Click once with the left mouse button.  A solid blue border will appear on 
the top and bottom of the item. 

 

 

3.  The item is now selected.  Menu commands and other actions can now 
be performed. 

 

 
Tip: 

•  When selecting a calendar item, It is important to single-click the left 
blue border, otherwise, Outlook will assume the user is trying to edit the 
text or subject of the item, and will go into edit mode for the item. 

 

 

 Calendar item in edit mode.  Notice the location has disappeared and 
the cursor is visible at the left edge of the text. 
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Procedure: (To open a calendar item) 

1.  Double-click with the left mouse button anywhere on the item. 

 OR 

 Click the left blue border of the item and select the File menu, choose 
Open, then Selected Items. 

 OR 

 Right-click with the mouse on the item and select Open.   

 

 

2.  The item displays in a separate window. 
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3.  Close the item when all desired actions have been completed. 
 

 
Tips: 

•  When using the double-click method, do not single-click the item before 
double-clicking it or the double-click will do nothing. 

•  When using the right-click method, do not single-click the item first, or 
Outlook will display the pop-up menu for editing an item. 

 

 

 The pop-up menu when item is in edit mode. 
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Understanding Calendar Item Definitions 

There are several terms and definitions that are specific to working in the 
Outlook calendar.  The calendar can contain three types of items:  
appointments, events, and meetings.  These terms are defined in the 
following table: 
 

Term Definition 

Appointment An activity that appears on the calendar that does not include 
other people or resources.  Some examples of appointments 
include answering e-mail, writing a proposal, lunch with a 
colleague, or a visit to the dentist.  Appointments can be marked 
as private, so that other users cannot view the detailed 
information about the activity. 

Meeting An item on the calendar that involves other people or resources 
and their Outlook calendars.  A weekly review with the sales 
department is an example of a meeting.  The current user can 
create meetings, or the user can be invited to meetings from 
other users. 

Event This activity does not necessarily block time on the calendar.  
Instead, the event appears as a banner at the top of the 
corresponding date(s).  Some examples of events are trade 
shows, seminars, anniversaries, or birthdays.  This category is 
also used when an appointment lasts longer than 24 hours. 
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 Working with the Calendar Toolbar 

The Calendar toolbar contains many of the commands and shortcuts to 
views that are needed to maneuver through this area of Outlook.  The 
following table describes the buttons available on the standard Calendar 
toolbar. 
 

 
 

Button Name Function 

 New Appointment Inserts a new appointment into the user’s 
calendar.  When working in the calendar, 
New Appointment is the default 
command.  Use the drop-down arrow to 
create a meeting request, task, new 
message, etc. 

 Print Prints the current calendar to the default 
printer with the default options. 

 Delete Deletes the selected item. 

 Calendar Coloring Assigns a background color and label 
name to the selected calendar item. 

 Today Displays the calendar for the current date.

 Day Displays one day in the calendar 
notepad. 

 Work Week Displays the work week without 
weekends (as defined in the calendar 
options). 

 Week Displays one week, including weekends. 

 Month Displays one month at a time in the 
calendar notepad. 

 Schedules Opens the Group Schedules dialog box. 
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Button Name Function 

 Find Opens the Find Bar to search for items 
based on specified words or other criteria.

 Organize Opens the Organize Pane to set options 
for categories and views. 

 Address Book Opens the Address Book. 

Find a Contact Type the name of a contact in this box to 
have Outlook search for it, and then 
display the contact window. 

 Outlook Help Launches the Office Assistant on-line 
help. 

 

 
Tips: 

•  When opened, the individual items in the calendar – appointments, 
events, and meetings – all have their own toolbars.  A description of 
each of these toolbars can be found in Appendix A. 

•  For the sake of clarity in this manual, the Standard toolbar of the 
Calendar folder will be referred to as the Calendar toolbar. 

•  All other Standard item toolbars will be referred to as their respective 
window names, i.e. the Appointment toolbar, the Meeting toolbar, etc. 
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Using the Date Navigator 

The Date Navigator, located in the upper right corner of the Outlook 
interface, allows the easy selection of any displayed date.  It also shows 
important information about the calendar.  The features of the Date 
Navigator are labeled and described below. 
 

 
 
The Forward and Backward controls scroll the Date Navigator one month 
forward and backward respectively. 
 
The Current Date, as determined by the workstation, will have a thin 
maroon border around it. 
 
The Viewed Date is the date currently being viewed in the calendar.  The 
date will appear in bold white print with gray shading.  More than one date 
can be viewed at a time. 
 
Dates with items that have a status of Busy, Tentative, or Out of Office 
will be in bold print.  This can be changed in the view options of the 
calendar (see Chapter 9 – Customizing the Calendar). 
 
The number of months shown in the Date Navigator can be changed by 
dragging the horizontal divider bar, as described earlier in this chapter. 

Backward Forward 

Current date 

Viewed date 

Date with a 
scheduled item 

Date with 
nothing 
scheduled 
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Accessing Calendar Views 

There are many ways to view the calendar.  The default view is called 
Day/Week/Month.  This view contains four basic variations that can be 
accessed via the Calendar toolbar.  These views are Day, Work Week, 
Week, or Month. 
 
The following procedure describes how to access these calendar views.  
The following topics describe each view in detail. 
 

 
Procedure: 

1.  Select the View menu, then Current View, and confirm that the 
Day/Week/Month view is selected.  (A checkmark will appear next to 
the view name.) 

 

 

2.  On the Calendar toolbar, click the desired view button. 
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Using the Day View 

  The Day view shows working hours in the designated background 
color (the default is yellow) and non-working hours in a shaded version of 
the background color. 
 
The Date Navigator is located in the top-right corner and the TaskPad is 
below it.  Days that have appointments or meetings scheduled will have 
the respective time periods blocked off in the calendar and the dates will 
be shown in bold in the Date Navigator. 
 

 
 
In addition to viewing just one day, Outlook allows the user to view several 
days at a time without switching to the Week view. 
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Procedure:  (To view several days in a row) 

1.  In the Date Navigator, select the first day of the series.  Hold down the 
[Shift] key and click the last day in the series. 

 OR 

 Drag over the days to be viewed in the Date Navigator. 

2.  Outlook displays the selected days in the main viewing area. 

 

 
 

 
Tip: 

•  When using the drag method to select days, Outlook will display up to 
six days in Day view.  When dragging seven days or more, Outlook will 
switch to Week or Month view. 

•  When using the [Shift] method, up to 14 days can be shown in Day 
view. 
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Procedure:  (To view non-consecutive days) 

1.  In the Date Navigator, select the first day. 

2.  Press and hold the [Ctrl] key and using the mouse, click the days to be 
viewed. 

3.  Outlook displays the selected days in the calendar notepad. 

 

 
 

 
Warning: 

•  The maximum number of non-consecutive days that can be selected is 
14. 
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Using the Work Week View 

  The Work Week view is basically Day view displaying the 
work days as defined in the calendar options.  The default is Monday 
through Friday, without Sunday or Saturday. 
 
All appointments, meetings, and any other scheduled items appear in an 
abbreviated manner.  The TaskPad and Date Navigator are also available 
in this view. 
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Using the Week View 

  The Week view is a two-column display with the first half of the 
week in the first column and the second half of the week in the second 
column. 
 
Similar to the Day view, the Date Navigator and the TaskPad remain 
visible.  The current week is highlighted in the Date Navigator.  The 
weekends are compressed into a single box. 
 

 
 
Use the following procedure to view more than one week in the Week 
view. 
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Procedure: 

1.  In the Date Navigator, drag over the weeks to be viewed. 

 

 
 

 
Warning: 

•  The maximum number of weeks that can be selected in this view is six. 
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Using the Month View 

  The Month view shows the desired month in its entirety.  Months 
are distinguished by color, alternating between white and gray.  The 
vertical scroll bar is used to navigate the months. 
 
By default, the Date Navigator and TaskPad are not in this view. 
 

 
 
Weekends in Month view can be compressed so that more screen space 
is used by the work days (as shown above).  This option can be changed 
in the View settings.  This setting will also affect the appearance of 
weekends in Week view.  See Chapter 9 – Customizing the Calendar 
for more information on setting calendar options. 
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Accessing Other Calendar Views 

In addition to the calendar-style views, the calendar can be viewed in a 
table style, with columns and headings like an Excel spreadsheet.  Table-
style views can be handy for viewing appointments and meetings by 
groups, or for printing items in a table format. 
 

 
 
There are five table-style views built into the calendar.  As with all Outlook 
views, they can be customized.  See Chapter 9 – Customizing the 
Calendar for more information. 
 

 
Procedure: 

1.  Select the View menu and choose Current View.  A submenu of 
available views displays: 
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2.  Using the following table, select one of the table-style views. 
 

Option Description 

Active 
Appointments 

Displays all appointments and meetings that start after the 
current date.  The items are grouped by Label. 

Events Displays all events and groups them by recurrence pattern - 
None, Daily, Weekly, etc. 

Annual Events Displays all events that occur yearly.  No grouping is applied in 
this view. 

Recurring 
Appointments 

Displays all currently active recurring appointments.  Items are 
grouped by recurrence pattern - Daily, Weekly, Monthly, or 
Yearly. 

By Category Displays all types of calendar items – appointments, meetings, 
and events – both past, current, and future.  Items are grouped 
by Category. 
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Using the Preview Pane 

While it is used primarily in the Inbox for e-mails, Outlook XP extends the 
functionality of the Preview Pane to all Outlook items, including 
appointments, meetings, and events. 
 
The Preview Pane allows the details of a calendar item to be viewed and 
edited without having to open the item as a separate window. 
 

 
Procedure: 

1.  From the Calendar folder, select the View menu and choose Preview 
Pane. 

2.  Select an item in the calendar.  The Preview Pane displays the details 
of the item: 
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Using the Reminders Window 

In previous versions of Outlook, reminders had to be processed one at a 
time, that is, there was a separate reminder window for every reminder.  If 
a user was out of the office for a while, there could be dozens of 
reminders to deal with upon return. 
 
Outlook XP provides a unified reminders window that presents all 
reminders in a single window, making it much easier to dismiss or snooze 
groups of reminders. 
 

 
 
The following table describes the buttons available in this window: 
 

Button Description 

Dismiss All Dismisses all reminders displayed in the reminders window.  If 
chosen, Outlook will ask to confirm this action. 

Open Item Opens a separate window with the selected item displayed. 

Dismiss Dismisses the reminder currently selected in the list. 

Snooze In combination with the snooze drop-down list, this button 
temporarily dismisses the reminder and will redisplay it at the 
designated interval. 

 
The Reminders window can also be displayed manually by selecting the 
View menu and choosing Reminders Window. 
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Changing the Time Bar 

Along the left side of the calendar notepad is the Time Bar.  The Time Bar 
displays 30-minute increments by default, however it can be set to display 
one of six different time increments – 60, 30, 15, 10, 6, or 5 minutes. 
 
Outlook keeps the height of each increment row constant, therefore a day 
divided up into 60-minute increments will be “shorter” (i.e. less scrolling), 
than one divided up into 10-minute increments. 
 

 

  

 60-minute increments 30-minute increments 

 

  

 15-minute increments 5-minute increments 
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Procedure: 

1.  Right-click the Time Bar in the calendar.  The pop-up menu displays: 

 

 

2.  Select the desired time increment with the left mouse button. 
 

 
Tip: 

•  The Time Bar can also be changed in the View settings.  See Chapter 9 
– Customizing the Calendar for more information. 
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Creating Other Calendar Folders 

In same manner that folders can be created to sort and file e-mails, 
additional calendar folders may be created for a variety of different 
projects and tasks. 
 
However, only the original default Outlook calendar can be shared with 
other users (see Chapter 7 – Sharing Calendars) and be used for 
scheduling meetings (see Chapter 4 – Working with Meetings). 
 

 
Procedure: 

1.  Select the File menu, choose New, then Folder. 

 OR 

   Click the drop-down arrow of the New button on the Calendar 
toolbar and select Folder. 

 OR 

 Press [Ctrl] + [Shift] + [E].  The Create New Folder dialog box 
displays: 
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2.  Type a Name for the calendar. 

3.  From the Folder contains drop-down list choose Calendar Items. 

4.  In the Select where to place the folder section, select the folder above 
where the calendar should appear.  (The Mailbox – <username> folder 
is recommended.) 

 

 

5.  Click OK to create the calendar.  The following dialog box displays: 

 

 

6.  To create a shortcut on the Outlook Bar, click Yes.  Otherwise, click No.  

7.  The newly created calendar now appears in the folder list. 
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Chapter 2 
Working with Appointments 

 

 
Chapter Objectives: 

•  Creating a New Appointment 

•  Editing an Appointment 

•  Deleting an Appointment 

•  Creating a Recurring Appointment 

•  Editing a Recurring Appointment 

•  Deleting a Recurring Appointment 
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Overview 

Appointments are the most common type of item added to a calendar.  As 
defined in the previous chapter, an appointment is an activity that appears 
on the calendar that does not include other people or resources. 
 
Appointments can either be created as single occurrences, such as a 
doctor’s appointment, or recurring appointments can be created for 
multiple occurrences that happen on a regular basis. 
 

Creating a New Appointment 

An appointment is an activity that does not involve other users or 
resources.  For instance, a doctor’s appointment, a training class, or 
reserving time to work on a project are all examples of appointments.  
There are several methods to start the creation of an appointment. 
 

 
Procedure: 

1.  Choose the day for the appointment using the Date Navigator. 

 OR 

 Press [Ctrl] + [G] to display the Go To Date dialog box.  Use the drop-
down box to select a date and click OK. 

 

 

2.  Choose the desired time slot.  Click once with the mouse to select a 
single time slot, or drag over multiple time slots to select a longer period.

3.  If one time slot is selected, double-click the time slot. 

 OR 

 Right-click the highlighted time block and choose New Appointment. 

 OR 
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   Click the New button on the Calendar toolbar.   

 OR 

 Press [Ctrl] + [N].  The Appointment window displays: 

 

 

4.  Use the following table to complete the fields in the Appointment 
window. 

 

Option Description 

Subject Type a descriptive name or title for the appointment.  The title bar 
of the appointment will change to match the subject. 

Location Enter the location of the appointment, or select a previously used 
location from the drop-down list.  Note: This does NOT schedule 
or reserve a conference room or resource. 

This is an online 
meeting 

This option is for use with meetings.  (Do not use at PGW.) 

Start time Type or use the drop-down boxes to enter the beginning date and 
time for the appointment. 
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Option Description 

All day event Select the check box to make the appointment an event.  (See 
Chapter 3 – Working with Events for more about events.) 

End time Type or use the drop-down boxes to enter the ending date and 
time for the appointment. 

Reminder Select this check box to set a reminder and use the 
corresponding drop-down list to select or type the amount of time 
prior to the appointment for the reminder to appear. 

Play a sound Select this button to choose the sound file to be played when the 
reminder appears. 

Show time as Choose Free, Tentative, Busy, or Out of Office from the drop-
down list.  This changes the appearance of available time when 
others view your schedule.  The default for appointments is 
Busy. 

Label Select a label (calendar coloring) for the appointment. 

Notes Type any additional details about the appointment in this area.  
This area is also used to insert or attach a file, such as an 
agenda.  Use the Insert, File menu command, or the Insert File 
button on the Appointment toolbar. 

Contacts Select this option to associate this appointment with members of 
the Contacts folder. 

Categories Select this option to place this appointment into a category. 

Private Select this check box so that the details of the appointment are 
hidden from others who have access to your schedule, i.e. your 
delegates or others who have read permission to your calendar. 

 

5.    Click the Save and Close button on the Appointment 
toolbar to save the appointment and place it on the calendar. 
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Editing an Appointment 

Once an appointment has been created and added to the calendar, it may 
be necessary to modify the information in the appointment. 
 

 
Procedure: 

1.  Open the appointment to be edited.  The Appointment window 
displays: 

 

 

2.  Make the desired changes in the Appointment window. 

3.    Click the Save and Close button on the Appointment 
toolbar when complete. 
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Tips: 

•  If the appointment’s starting time is changed, Outlook automatically 
updates the end time to maintain the original appointment duration. 

•  
  Drag-and-drop can be used to change an appointment time.  

Position the cursor on the left edge of the appointment.  When the 
cursor changes to a cross-hair, drag the appointment to an alternate 
time within the same day or onto the Date Navigator to move the 
appointment to a different day. 

•  To extend or shorten the time of an appointment, position the mouse 
along the top or bottom edge of the appointment’s box.  The pointer will 
change to a double arrow.  Drag the border to specify the new length. 

 

 

•  Appointments can be moved and copied by using the Cut, Copy, and 
Paste commands on the Edit menu in the Calendar window. 

•  Appointment details can be edited without opening the Appointment 
window if the appointment is selected and the Preview Pane is visible. 
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Deleting an Appointment 

Cancelled appointments can easily be removed from the calendar by 
using the Delete command. 
 

 
Procedure: 

1.  Select the appointment to be deleted. 

2.  Select the Edit menu and choose Delete. 

 OR 

 Press [Ctrl] + [D]. 

 OR 

 Press [Delete]. 

 OR 

   Click the Delete button on the Calendar toolbar. 

3.  The appointment is removed from the calendar and placed in the 
Deleted Items folder. 

 

 
Tip: 

•  When deleting an appointment, be sure to select it by clicking the left 
border, otherwise, Outlook will assume the user is trying to edit the 
appointment subject, and will only delete text in the appointment box. 
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Creating a Recurring Appointment 

There is often a need to schedule appointments that will recur on a regular 
basis.  Any appointment that occurs regularly can be set up quickly and 
easily, without having to create multiple single appointments or using copy 
and paste. 
 
Additionally, appointments that have already been created can be 
converted into recurring appointments. 
 

 
Procedure: (To create a recurring appointment) 

1.  Select the Actions menu and choose New Recurring Appointment. 

 OR 

 Select a time block on the calendar, right-click with the mouse and 
choose New Recurring Appointment.  The Appointment Recurrence 
dialog box displays: 

 

 

2.  Use the following table to complete the options in this dialog box: 
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Option Description 

Appointment 
Time 

Verify, type, or use the drop-down lists to enter the Start and End 
times, as well as the Duration of the recurring appointment. 

Recurrence 
Pattern 

Select either Daily, Weekly, Monthly, or Yearly to specify the 
general recurrence interval of the appointment.  Use the check 
boxes and/or drop-down lists on the right side of this section to 
indicate the specific recurrence interval. 

Range of 
recurrence 

In the Start box, type or use the drop-down box to enter the date 
of the first occurrence of the recurring appointment. 

No end date Select this option to repeat the recurring appointment indefinitely. 

End after Select this option when the recurring appointment ends after a 
specific number of occurrences.  Type the number of occurrences 
of the recurring appointment in the box. 

End by Select this option when the recurring appointment ends on a 
specific date.  Type or use the drop-down box to enter the date of 
the last occurrence of the appointment. 

 

3.  Click OK when complete. 

4.  Fill out the rest of the appointment details as desired. 

5.    Click the Save and Close button on the Appointment 
toolbar when finished. 

6.  Outlook displays all of the individual appointments on the calendar on 
their respective dates with the recurrence symbol in the appointment 
(two arrows in a circle). 
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Procedure: (To convert an appointment to a recurring appointment) 

1.  Open the appointment. 

2.    Click the Recurrence button on the Appointment 
toolbar. 

 OR 

 Select the Actions menu and choose Recurrence. 

 OR 

 Press [Ctrl] + [G].  The Appointment Recurrence dialog box displays: 

 

 

3.  Select the desired recurrence options (see the previous procedure for 
details) and click OK. 

4.    Click the Save and Close button on the Appointment 
toolbar. 
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Editing a Recurring Appointment 

After a recurring appointment has been added to the calendar, it can be 
edited as needed.  For instance, an appointment that normally occurs at a 
regular time may occasionally need to be moved to a different time.  
Outlook allows exceptions to recurring appointments and keeps those 
exceptions as part of the entire series. 
 
When editing a recurring appointment, the user must first decide whether 
to modify only the current instance of the appointment, or if all of the 
appointments in the series need to be changed. 
 
Follow the appropriate procedure listed below to make changes as 
needed to recurring appointments. 
 

 
Procedure:  (To edit one occurrence of a recurring appointment) 

1.  Open the recurring appointment that is to be changed.  The Open 
Recurring Item dialog box displays: 

 

 

2.  Choose Open this occurrence and click OK.  The Recurring 
Appointment window displays: 
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3.  Make the appropriate changes in this occurrence of the recurring 
appointment. 

4.    Click the Save and Close button on the Appointment 
toolbar when complete.  Only the selected appointment has been 
changed.  All other occurrences of the appointment remain the same. 

5.  Outlook changes the recurrence symbol (the two arrows in a circle now 
have a slash through them) in the calendar to indicate that an exception 
or change to the series has been made. 

 

 

 OR 

 Drag the left border of the appointment to the desired time slot.  Outlook 
will change the icon to show the appointment has been changed. 
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Procedure: (To change all appointments in a series) 

1.  Open the recurring appointment that is to be changed.  The Open 
Recurring Item dialog box displays: 

 

 

2.  Choose Open the series and click OK.  The Recurring Appointment 
window displays. 

3.    Click the Recurrence button on the Appointment 
toolbar. 

 OR 

 Select the Actions menu and choose Recurrence. 

 OR 

 Press [Ctrl] + [G].  The Appointment Recurrence dialog box displays: 
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4.  Change the date, time, or recurrence pattern as desired. 

5.  Click OK to accept the changes.  The InfoBar of the appointment will 
indicate if there are any conflicts with appointments already on the 
calendar. 

6.    Click the Save and Close button on the Appointment 
toolbar when complete.  The changes will appear in the remaining 
recurring appointments. 

 

 
Warning: 

•  When editing the series, previous changes to individual appointments 
will be lost. 
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Deleting a Recurring Appointment 

Similar to editing a recurring appointment, either a single occurrence of a 
recurring appointment can be deleted, or the entire recurring series can be 
removed from the calendar. 
 

 
Procedure: 

1.  Select the appointment to be deleted. 

2.  Select the Edit menu and choose Delete. 

 OR 

 Right-click the appointment and choose Delete. 

 OR 

 Press the [Delete] key.   

 OR 

   Click the Delete button on the Calendar toolbar.  The Confirm 
Delete dialog box displays: 

 

 

3.  Choose either Delete the series to remove the entire recurring series or 
Delete this occurrence to remove a single occurrence. 

4.  Click OK to accept. 

5.  The appointment(s) will be removed from the calendar. 
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Chapter 3 
Working with Events 

 

 
Chapter Objectives: 

•  Creating an Event 

•  Editing an Event 

•  Deleting an Event 

•  Working with Recurring Events 

•  Changing an Event to an Appointment 
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Overview 

An event is generally an activity that lasts 24 hours or more.  Events do 
not appear as blocks of time on the calendar, but instead, appear as a 
banner across the top of the day(s) of the event.  Some examples of 
events include trade shows, conferences, birthdays, or anniversaries. 
 
By default, events do not “block off” time in the calendar like 
appointments.  Days that have events will not have dates in bold format in 
the Date Navigator.  This can be changed when creating the event. 
 
Events have many similar characteristics to appointments, and both types 
of items can easily be converted into the other. 
 

Creating an Event 

An event is actually an appointment that has the All day event check box 
enabled.  While the initial process for creating an event is slightly different, 
all other details for creating an event and filling out its details are exactly 
the same as creating an appointment. 
 

 
Procedure: 

1.  Select the date on which the event occurs. 

2.  Double-click in the calendar banner area below the date heading. 

 

 

 OR 
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 Right-click the calendar and select New All Day Event. 

 OR 

 Select the Actions menu and choose New All Day Event.  The Event 
window displays: 

 

 

3.  Fill out the event fields.  Use the table in Chapter 2 – Working with 
Appointments for a complete description of each field. 

4.  In the Show time as drop-down list, choose Free, Tentative, Busy, or 
Out of Office.  This option controls the display of the time on a user’s 
calendar to other users.  Free is the default for events and will allow the 
user to schedule other appointments and meetings without creating a 
conflict.  Set Show time as to Busy or Out of Office to “block off” the 
time in the calendar and have the date show up in bold font in the Date 
Navigator. 

5.    Click the Save and Close button on the Event toolbar 
when complete. 

6.  The event now appears in the banner below the date. 
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Tips: 

•  By default, events last from midnight to midnight. 

•  Any day may have multiple events, however, once an event is added, 
the banner area collapses to the size of the first event and it is difficult to 
double-click in the area to create a new event.  Use one of the other 
methods (right-click or the Actions menu) to create additional events. 
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Editing an Event 

Once an event has been created and saved to the calendar, it can be 
opened to make changes or modifications to the event details. 
 

 
Procedure: 

1.  Right-click the event to be edited and choose Open.   

 OR 

 Double-click the event to be edited.  The Event window displays: 

 

 

2.  Make the desired changes. 

3.    Click the Save and Close button on the Event toolbar 
when complete. 

 

 
Tip: 

•  To edit only the subject of the event, click the event name and make 
changes.  Click anywhere on the calendar to exit the edit mode. 
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Deleting an Event 

If an event is no longer needed on the calendar or has been cancelled, it 
can be removed. 
 

 
Procedure: 

1.  Select the event with the mouse. 

2.  Select the Edit menu and choose Delete. 

 OR 

 Press [Ctrl] + [D]. 

 OR 

   Click the Delete button on the Calendar toolbar. 

3.  Outlook removes the event from the calendar. 
 

 
Tip: 

•  An event can also be deleted by right-clicking the event and selecting 
Delete from the pop-up menu. 

 

 
Warning: 

•  An event cannot be deleted by using the [Delete] key. 
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Working with Recurring Events 

Like appointments, events can be made to recur on a regular basis, such 
as monthly or yearly (i.e. birthdays and holidays).  Events are created, 
edited and modified, and deleted in the same manner as appointments. 
 
Recurring events will have the recurring symbol next to the subject of the 
event in the calendar. 
 

 
 
Please refer to the topics Creating a Recurring Appointment, Editing a 
Recurring Appointment, and Deleting a Recurring Appointment in 
Chapter 2 – Working with Appointments of this manual for the specific 
procedures. 
 
When creating a recurring event, choose New Recurring Event from the 
menu instead of New Recurring Appointment. 
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Changing an Event to an Appointment 

By definition, events are essentially appointments that last 24 hours or 
more, display no specific start and end time (midnight to midnight is 
assumed), and by default, show time on the calendar as free.  However, 
there may be times that converting an event into an appointment is 
desired so that specific start and end times can be entered. 
 

 
Procedure: 

1.  Right-click the event to be edited and choose Open.   

 OR 

 Double-click the event to be edited.  The Event window displays: 

 

 

2.  Clear the All day event check box.  The following changes will occur: 
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 • The Start time and End time time drop-down boxes will reappear. 

• The title of the window will change from Event to Appointment. 

• If a Reminder was selected, it will change to the default for 
appointments (usually 15 minutes). 

• The Show time as field will change to Busy. 

3.  Fill in a start time and end time for the appointment. 

4.  Make any other additions or corrections as needed. 

5.    Click the Save and Close button on the Appointment 
toolbar. 

 

 
Tip: 

•  This process can easily be reversed, that is, an appointment can be 
converted to an event by selecting the All day event check box. 
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Chapter 4 
Working with Meetings 

 

 
Chapter Objectives: 

•  Understanding the Meeting Planner 

•  Scheduling a Meeting 

•  Editing a Meeting Request 

•  Adding or Removing Meeting Attendees 

•  Processing Meeting Request Responses 

•  Checking Meeting Attendee Status 

•  Managing New Meeting Time Proposals 

•  Cancelling a Meeting 

•  Sending a Message to Meeting Attendees 

•  Responding to a Meeting Request 

•  Proposing a New Meeting Time 

•  Cancelling Attendance at a Meeting 

•  Receiving a Meeting Cancellation 

•  Working with Recurring Meetings 
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Overview 

Meetings and appointments are similar, however, an appointment involves 
only the person using the calendar and their time, whereas a meeting 
involves inviting others and coordinating their schedules.  Another 
difference is that a meeting may require the scheduling of resources, such 
as a conference room or an overhead projector. 
 
This chapter covers scheduling one-time and recurring meetings, 
responding to meeting requests, making changes to meetings, cancelling 
meetings, and tracking responses to meetings. 
 
This chapter’s topics are organized around the two basic roles that come 
into play with meetings – the Meeting Organizer and the Meeting 
Attendees. 
 

Understanding the Meeting Planner 

Outlook XP includes many improvements to the Meeting Planner.  This 
window is displayed when the Plan a Meeting feature is used, or the 
Scheduling tab of a meeting invitation is selected.  It is also nearly 
identical to the Group Schedule window (see Chapter 6 – Managing 
Group Schedules). 
 

 
 
The following table describes the labeled sections of this window and their 
use: 
 

Zoom 

Attendee 
Type Icons 

Options 

AutoPick 

Availability 

Window 
controls

Start/End 
bars 

Scroll bars 

Start/End 
drop-down 
boxes
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Feature Description 

Zoom 

 

Use this drop-down list to control how much information is 
displayed in the planner window.  This can be adjusted from 50% 
(Week View) to 500%. 

Attendee Type 
Icons 

Meeting Organizer (black) 

Required Attendee (maroon) 

Optional Attendee (blue) 

Resource (green) 

These icons indicate the role of each attendee.  To change an 
attendee’s status, click the attendee icon to display a drop-down 
list and select a new status. 

Options 

 

This drop-down menu controls what is displayed in the planning 
grid and the behavior of the AutoPick feature.  Calendar details 
will only be displayed if the meeting attendee has granted 
delegate or read permission to the meeting organizer. 
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Feature Description 

AutoPick Use these buttons to have Outlook automatically select a meeting 
time when attendees (as set by the AutoPick Options) are 
available.  The main or larger button moves forward in time, while 
the smaller button moves backwards.  Each click will jump to 
another available time slot.  The backward button cannot select a 
time before the current time. 

Availability Busy. The member is not available.  These appointments are 
shown in solid blue. 

Tentative. The block of time is tentatively scheduled.  Tentative 
appointments are colored blue with diagonal white stripes. 

Out Of Office. The member is on vacation, at a conference, or 
otherwise indisposed.  These times are shown in purple. 

No Information. There is no information about the member’s 
schedule.  Such blocks of time are shown as white areas with 
diagonal black lines.  This might indicate that the member does 
not use Outlook, the account is new or does not exist, or that 
there are other problems with the account. 

Window controls The Meeting Planner window can be sized like most application 
windows.  This allows the planner to be maximized and 
minimized. 

Start/End bars These bars – the left one is green, the right one is red – indicate 
the start and end time of the meeting.  They can be dragged to 
change the meeting date, time, and length. 

Scroll bars The horizontal scroll bar is used to scroll forward and backward 
through time.  The vertical scroll bar – if available – will scroll 
through the list of attendees. 

Start/End drop-
down boxes 

Use these drop-down boxes to select a meeting date and time.  
These will update automatically if the Start/End bars are moved. 
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Working as a Meeting Organizer 

The next set of topics in this chapter pertain to the role of Meeting 
Organizer.  The meeting organizer is the person who is in control of the 
meeting, and makes the initial meeting request. 
 
The topics covered in this section are: 
 

• Scheduling a Meeting 
 

• Editing a Meeting Request 
 

• Adding or Removing Meeting Attendees 
 

• Processing Meeting Request Responses 
 

• Checking Meeting Attendee Status 
 

• Managing New Meeting Time Proposals 
 

• Cancelling a Meeting 
 

• Sending a Message to Meeting Attendees 
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Scheduling a Meeting 

A meeting is defined as an activity that involves other people or resources, 
such as a conference room or television.  When scheduling a meeting, the 
meeting organizer compares free time on other users’ schedules to find 
potential meeting times.  Meeting attendee “free” and “busy” times are 
displayed in the Meeting Planner.  The name of each attendee appears 
next to their information making it simple to view their schedules. 
 
There are two ways to schedule a meeting.  The first method involves 
having a specific date and time for the meeting already in mind, the other 
involves knowing who should be invited, and attempting to find a date and 
time when everyone can be present. 
 

 
Procedure: (To schedule a meeting knowing the desired date and 
time) 

1.  In the calendar notepad, select a date and time for the meeting. 

2.  Select the Actions menu and choose New Meeting Request. 

 OR 

 Right-click the selected time block and choose New Meeting Request.  
The Meeting window displays: 
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3.  Click To.  The Select Attendees and Resources dialog box displays: 

 

 

4.  In the Type Name or Select from List area, choose the names of the 
other meeting attendees, and then select one of the following 
attendance category buttons: 

 

Button Description 

Required The person must attend. 

Optional The person is invited but does not have to attend. 

Resources This may be any additional materials or persons needed for the 
meeting, such as a conference room or projector. 

 

5.  Click OK when all attendees have been selected.   

6.  The selected names appear in the To field. 
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7.  If desired, select the Scheduling tab to view the invitees’ calendars. 
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8.  If any invitee is unavailable during the selected time, choose a new time 
by either dragging the Start and End bars, using the Meeting Start 
Time and End Time drop-down boxes, or use the AutoPick feature to 
have Outlook choose a time automatically. 

9.  Select the Appointment tab to return to the meeting invitation.  Use the 
following table to complete the fields in the meeting invitation: 

 

Option Description 

Subject Type a descriptive name or title for the meeting.  The title bar of 
the meeting invitation will change to match the subject. 

Location Enter the location of the meeting, or select a previously used 
location from the drop-down list.  Note: This does NOT schedule 
or reserve a conference room or resource.  In order to reserve a 
conference room using the calendar, there must be an entry for 
the conference room in the Global Address List, and it must be 
invited to the meeting in the same manner as a person. 

This is an online 
meeting 

Check this option to create an online meeting using an 
online/internet meeting service.  (Do not use at PGW). 

Start time Type or use the drop-down boxes to enter the beginning date and 
time for the meeting. 

All day event Select this check box to make the meeting an event.  (See 
Chapter 3 – Working with Events for more information.) 

End time Type or use the drop-down boxes to enter the ending date and 
time for the meeting. 

Reminder Select this check box to set a reminder and use the 
corresponding drop-down list to select or type the amount of time 
prior to the meeting for the reminder to appear. 

Play a sound Select this button to choose the sound file to be played when the 
reminder appears. 

Show time as Choose Free, Tentative, Busy, or Out of Office from the drop-
down list.  This changes the appearance of available time when 
others view your schedule.  The default for meetings is Busy. 
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Option Description 

Label Select a label (calendar coloring) for the meeting.  This applies to 
the meeting organizer only.  Meeting attendees will be able to 
assign their own labels. 

Notes Type any additional details about the appointment in this area.  
This area is also used to insert or attach a file, such as a meeting 
agenda.  Use the Insert, File menu command, or the Insert File 
button on the Meeting toolbar. 

Contacts Select this option to associate this meeting with members of the 
Outlook Contacts folder.  Note: This does not invite the contact to 
the meeting. 

Categories Select this option to display the Categories window and place this 
meeting into one or more categories. 

Private Select this check box so that the details of the meeting are 
hidden from others who have access to your schedule, i.e. your 
delegates or others who have read permission to your calendar. 

 

10.    Click the Send button on the Meeting toolbar to send a 
meeting request to each of the selected attendees. 
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Procedure: (To schedule a meeting without a date and time) 

1.  Select the Actions menu and choose Plan a Meeting.  The Plan a 
Meeting window displays: 

 

 

2.  Click Add Others and choose Add from Address Book.  The Select 
Attendees and Resources dialog box displays: 
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3.  In the Type Name or Select from List area, choose the names of the 
other meeting attendees, and then choose either Required, Optional, 
or Resources.  (See the previous procedure for a complete description 
of these categories). 

4.  Click OK when all attendees have been selected.  The Plan a Meeting 
window displays the meeting attendees in the All Attendees list: 

 

 

5.  Choose a time for the meeting by either dragging the Start and End 
bars, using the Meeting Start Time and End Time drop-down boxes, or 
use the AutoPick feature to have Outlook choose a time automatically. 

6.  Once a time, date, duration have been chosen, click Make Meeting.  
The Meeting window displays: 
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7.  Using the table in the previous procedure, fill out the remaining fields as 
necessary. 

8.    Click the Send button on the Meeting toolbar to have Outlook 
send the meeting invitation to the invitees. 

 

 
Tips: 

•  To convert a meeting invitation into an appointment, click the Cancel 
Invitation button on the Meeting toolbar. 

•  If meeting response e-mails from invitees are not desired, select the 
Actions menu and uncheck Meeting Responses.  Meeting attendee 
status can still be checked via the original meeting request.  

•  To prevent meeting attendees from proposing new times for a meeting, 
select the Actions menu and uncheck Allow New Time Proposals. 

•  To indicate an importance for the meeting to the invitees, click either the 
Importance: High or Importance: Low buttons on the Meeting toolbar. 
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Editing a Meeting Request 

After the initial meeting request has been sent to the attendees, it may be 
necessary to change some aspect of the meeting, such as the date, time, 
length, or location. 
 

 
Procedure: 

1.  Open the meeting.  The Meeting window displays: 

 

 

2.  On the Appointment tab, make the desired changes to the meeting. 

 OR 

 Select the Scheduling tab to make changes to the date, time, or length 
of the meeting using the Meeting Planner. 

3.    Click the Send Update button on the Meeting toolbar to 
send an e-mail notice to all meeting attendees. 

 OR 
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   Click the Save and Close button on the Meeting 
toolbar.  The following dialog box displays if changes were made to the 
date, time, or length of the meeting: 

 

 

4.  Click Yes to send the update notice to the meeting attendees. 
 

 
Warning: 

•  Outlook will only automatically ask to send an update to meeting invitees 
if changes are made to the date, time, or length of the meeting.  For 
example, if text is added to the notes area, and the user clicks Save and 
Close, Outlook will not ask to send an update.  To ensure that an 
update is sent to meeting invitees, it is best to click the Send Update 
button on the Meeting toolbar. 

 

 
Tips: 

•  
  Meeting update notices will have the same e-mail icon as the 

original meeting invitation, however, the word Updated will appear at 
the beginning of the Subject line. 

•  Meeting update notices will contain the same response buttons (Accept, 
Tentative, Decline) as the initial meeting invitation.  Meeting invitees 
will be able to respond to the update as they did the initial invitation. 

•  If the time, date, or duration has not changed, selecting Accept on the 
update notice will not add the meeting to the calendar again. 
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Adding or Removing Meeting Attendees 

A meeting organizer can add or remove meeting attendees from a 
meeting once it has been scheduled. 
 

 
Procedure: (To add attendees to a meeting) 

1.  Open the meeting to be edited.  The Meeting window displays. 

2.  Click To. 

 OR 

 Select the Scheduling tab, click Add Others, and then choose Add 
from Address Book.   

 OR 

 Select the Actions menu and choose Add or Remove Attendees.  The 
Select Attendees and Resources dialog box displays. 

3.  Select the additional attendees and click OK. 

4.    Click the Save and Close button on the Meeting 
toolbar.  The Send Update to Attendees dialog box displays: 

 

 

5.  Choose the desired option and click OK. 
 



Chapter 4 – Working with Meetings 

Page 72  © 0A316 

 
Procedure: (To delete attendees from a meeting) 

1.  Open the meeting to be edited.  The Meeting window displays. 

2.  In the To field, click the attendee name to be deleted and press the 
[Delete] key. 

 

 

3.    Click the Save and Close button on the Meeting 
toolbar.  The Send Update to Attendees dialog box displays: 

 

 

4.  Choose the desired option and click OK. 
 



Chapter 4 – Working with Meetings 

© 0A316  Page 73 

Processing Meeting Request Responses 

When a meeting invitation is sent, the meeting attendee initially has the 
choice of responding with Accept, Tentative, Decline, or Propose New 
Time. 
 
Once the attendee selects one of these options, they then have the option 
to send a response to the meeting organizer.  If either the Send response 
now or Edit the response before sending option is chosen by the 
meeting attendee, an e-mail is sent to the meeting organizer. 
 
The following table shows the e-mail icons associated with each meeting 
response that a meeting organizer will see in the Inbox. 
 

Icon Description 

 
The meeting has been accepted.  Accepted will appear in the 
Subject line of the e-mail. 

 
The meeting has been accepted tentatively.  Tentative will 
appear in the Subject line of the e-mail. 

OR 

The meeting attendee has proposed a new time for the meeting.  
New Time Proposed will appear in the Subject line of the e-
mail. 

 
The meeting has been declined.  Declined will appear in the 
Subject line of the e-mail. 

 
Meeting request responses can be deleted, moved, forwarded, and replied 
to like standard e-mails. 
 
Once meeting responses are read by the meeting organizer, the attendee 
information in the Tracking tab of the meeting is updated automatically. 
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Checking Meeting Attendee Status 

After a meeting request has been sent, the meeting organizer can check 
whether attendees have accepted or declined the meeting invitation.  This 
procedure is more reliable than keeping track of individual meeting 
request responses, since the meeting attendees are not required to send 
a response. 
 
The Tracking tab of the meeting, which is added after the meeting 
request has been sent, shows each invited attendee, their attendance 
status (required or optional), and their response status.  The meeting 
organizer is the only person who can view the status of attendees. 
 

 
Procedure: 

1.  Open the meeting.  The InfoBar of the meeting will contain a summary 
of the responses to date: 

 

 

2.  Select the Tracking tab to view detailed information about each 
attendee and their response status. 
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3.    Click the Save and Close button on the Meeting toolbar 
when finished. 

 

 
Tip: 

•  In some cases, the information on the Tracking tab may appear to not 
be current, especially when a meeting attendee has chosen not to send 
a response.  Check the meeting again later to see if the responses have 
updated by the server. 
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Managing New Meeting Time Proposals 

If enabled, meeting attendees have the option of proposing new dates and 
times for meetings that they have been invited to.  For example, a meeting 
attendee’s calendar may show them as Free or available, but they may 
have reasons for wanting the meeting on another date and time. 
 
If new meeting time proposals are received, the meeting organizer will 
need to review the proposals and either accept the proposed date and 
time or do nothing to leave the meeting at its scheduled time. 
 
When a proposal is accepted, the meeting organizer should send an 
update to the attendees informing them of the change.  The attendees will 
again be able to Accept or Decline the updated meeting invitation. 
 

 
Procedure: (To review and accept a single proposal) 

1.  Open the meeting response e-mail.  The InfoBar will indicate the 
attendee has tentatively accepted the meeting and proposed a new 
time. 
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2.  Review the Current and Proposed information for the meeting. 

3.    To accept the proposed date and time, click the Accept 
Proposal button on the Meeting Response toolbar.  The Meeting 
window displays: 

 

 

4.  Type a message to the meeting attendees and/or set any additional 
meeting options as desired. 

5.    Click the Send Update button on the Meeting toolbar to 
send an updated meeting request notice to the meeting attendees. 
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Procedure: (To review multiple proposals) 

1.  Open any of the New Time Proposed e-mails. 

2.    Click the View All Proposals button on the Meeting 
Response toolbar.  The Meeting window displays with the Scheduling 
tab open: 

 

 

3.  Review the proposals in the Proposed Date and Time area.  Click a 
proposal to display it in the scheduling grid. 

4.  To accept a proposal, select it in the Proposed Date and Time area. 

5.  Click the Appointment tab.  The Start and End Time of the meeting will 
change to reflect the selected proposal. 

6.    Click the Send Update button on the Meeting toolbar to 
send an updated meeting request notice to the meeting attendees. 
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Tips: 

•  To reject a proposed date and time for a meeting, simply close the 
meeting response e-mail or close the Meeting window and do not select 
one of the proposals. 

•    The meeting organizer may click the Reply button on the Meeting 
Response toolbar and write a message to the meeting attendee 
explaining why the proposal was not accepted. 

•  To prevent meeting attendees from proposing new times for a meeting, 
select the Actions menu when creating the meeting and uncheck Allow 
New Time Proposals. 

 

 

•  Outlook can be configured so that new meeting time proposals are 
always disabled for authored meetings.  See Chapter 9 – Customizing 
the Calendar for more information. 
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 Cancelling a Meeting 

When a meeting must be cancelled, a message can be generated to all 
attendees notifying them of the cancellation.  The meeting cancellation 
notice allows meeting attendees to easily remove the meeting from their 
calendars. 
 

 
Procedure: 

1.  Open the meeting to be cancelled.  Select the Actions menu and 
choose Cancel Meeting. 

 OR 

 Select the meeting and press the [Delete] key.  The following dialog 
box displays: 

 

 

2.  Choose Send cancellation and delete meeting to send a notification 
message to the attendees as well as delete the meeting from the 
calendar. 

 OR 

 Choose Delete without sending a cancellation to remove the meeting 
from the calendar without notifying the attendees that the meeting has 
been cancelled. 

3.  Click OK. 

4.  If the cancellation notice option was selected, the Meeting window 
displays: 
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5.  If desired, type a reason for the cancellation in the notes area. 

6.    Click the Send button on the Meeting toolbar to send the 
cancellation notice to the attendees. 
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Sending a Message to Meeting Attendees 

Once a meeting has been scheduled, Outlook provides a convenient way 
to send an e-mail message to the meeting attendees without having to 
create an e-mail from scratch. 
 

 
Procedure: 

1.  Open the meeting. 

2.  Select the Actions menu and choose New Message to Attendees.  A 
message window with the meeting attendees in the To line and the 
meeting subject in the Subject line displays: 

 

 

3.  Type the message and add any additional message options as desired. 

4.    Click the Send button on the Message toolbar to send the e-
mail. 
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Working as a Meeting Attendee 

The next set of topics in this chapter pertain to the role of Meeting 
Attendee.  Meeting attendees are those people who have been invited to 
the meeting by the meeting organizer. 
 
Meeting attendees do not have any control over the meeting scheduling, 
but can control their attendance at the meeting. 
 
The topics covered in this section are: 
 

• Responding to a Meeting Request 
 

• Proposing a New Meeting Time 
 

• Cancelling Attendance at a Meeting 
 

• Receiving a Meeting Cancellation 
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Responding to a Meeting Request 

Meeting requests are sent via Outlook e-mail and are received in the 
Inbox like other messages.  An enhancement to Outlook XP is the ability 
to respond to meeting requests from the Preview Pane. 
 
When a meeting request appears in the Inbox, the selects a response 
which is then sent back to the meeting organizer.  If the invitation is 
accepted, the meeting is automatically entered into the calendar. 
 

 
Procedure: 

1.  
  From the Inbox, open the meeting request.  Any conflicts will be 

listed in the InfoBar. 

 

 

2.  Choose one of the following options as a response to the meeting 
request: 
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Option Description 

Accept Accepts the meeting and places it on the calendar. 

Tentative Tentatively accepts the meeting and places it on the calendar. 

Decline Declines the meeting and does not place it on the calendar. 

Propose New Time Opens the Meeting Planner to search for and propose an 
alternate time and/or date for the meeting.  (See the next topic 
for more information). 

Calendar Displays the calendar with the meeting scheduled tentatively. 

Forward (button 
image only) 

Forwards the meeting invitation to another user to invite them 
as an optional attendee. 

 

3.  If Accept, Tentative, or Decline is selected, the following dialog box 
displays.  (The Tentative and Decline options will have slightly different 
wording, but the options will be the same). 

 

 

 The following table describes these options: 
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Option Description 

Edit the response 
before sending 

Allows the attendee to write a message back to the 
meeting organizer in conjunction with their response to the 
meeting request. 

Send the response 
now 

Sends an automated response to the meeting organizer 
with the selected choice in the subject of the e-mail. 

Don’t send a response Performs the selected choice but does not send an e-mail 
response to the meeting organizer. 

 

4.  Choose the appropriate option and click OK. 

5.  If the Edit the response before sending option was selected, Outlook 
displays a Meeting Response window.  The previous choice of Accept, 
Tentative, or Decline will be included in the Subject of the message. 
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6.  Write a response and set any other message options as desired. 

7.    Click the Send button on the Meeting Response toolbar to 
reply to the meeting organizer. 

 

 
Tips: 

•  The Preview Pane can be used to respond to a meeting invitation, 
however, only the Accept, Tentative, Decline, and Propose New Time 
buttons will be displayed. 

•  Outlook can automatically accept non-conflicting meeting requests, as 
well as decline conflicting requests.  See Chapter 9 – Customizing the 
Calendar for more information. 

•  Outlook can be configured so that only delegates receive meeting 
invitations and handle responses.  See Chapter 7 for more information. 

•  By default, Outlook will automatically delete a meeting invitation from the 
Inbox once a response has been sent.  This can be changed in the 
calendar options.  See Chapter 9 for more information. 
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Proposing a New Meeting Time 

If enabled by the meeting organizer, meeting invitees have the option of 
proposing new times and/or dates for a meeting.  For instance, a meeting 
attendee’s calendar may show them as free at a certain time, but the 
attendee might prefer to have the meeting at another time. 
 
The Propose New Time window is a modified Meeting Planner window.  
See Understanding the Meeting Planner earlier in this chapter for more 
details about the features of this window. 
 

 
Procedure: 

1.    Open the meeting request notice and click the 
Propose New Time button on the toolbar. 

 OR 

 In the Preview Pane click Propose New Time.  The Propose New 
Time window displays: 

 

 

2.  Use either the Start and End bars, AutoPick, or the Meeting Start and 
End time drop-down boxes to select a new time for the meeting.  To 
restore the original meeting time, click Current Meeting Time. 
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3.  Click Propose Time.  The Meeting Response window displays: 

 

 

4.  Type a message if desired and set any message options as needed. 

5.    Click the Send button on the Meeting Response toolbar to 
send the proposal to the meeting organizer. 

 

 
Tips: 

•  To quit creating a new time proposal and return to the original meeting 
invitation, click Cancel in the Propose New Time window. 

•  To cancel a new time proposal before it is sent, Close the e-mail without 
sending it. 
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Cancelling Attendance at a Meeting 

After a meeting has been accepted and placed on the calendar, a meeting 
attendee may choose at a later date to cancel their attendance.  Use 
either of the procedures below to cancel meeting attendance. 
 

 
Procedure: 

1.  Select the meeting in the calendar. 

2.    Click the Delete button on the Calendar toolbar. 

 OR 

 Press the [Delete] key.  The Confirm Delete dialog box displays: 

 

 

3.  Choose the desired option and click OK.   

4.  If the Delete and send a response option was selected, the following 
dialog box displays: 

 

 

5.  Choose the desired option and click OK. 
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6.  If Edit the response before sending option was selected, Outlook 
displays a Meeting Response window with Declined in the Subject. 

7.  Write a response and set any other message options as desired. 

8.    Click the Send button on the Meeting Response toolbar to 
reply to the meeting organizer. 

 

 
Procedure: 

1.  Open the meeting on the calendar. 

2.  Select the Actions menu of the meeting and choose Decline. 

 OR 

   Click the Decline button on the Meeting toolbar.  The 
following dialog box displays: 

 

 

3.  Choose the desired option and click OK. 

4.  If Edit the response before sending was selected, Outlook displays a 
Meeting Response window with Declined in the Subject. 

5.  Write a response and set any other message options as desired. 

6.    Click the Send button on the Meeting Response toolbar to 
reply to the meeting organizer. 
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Receiving a Meeting Cancellation 

When a meeting is cancelled by the organizer, Outlook will send a notice 
to all meeting attendees if the organizer has selected the Send 
cancellation and delete meeting option. 
 

 
Procedure: 

1.  
  In the Inbox, open the meeting cancellation notice.  The 

Canceled: Meeting notice displays: 

 

 

2.    Click the Remove from Calendar button on the 
Meeting Cancellation toolbar to have Outlook automatically delete the 
meeting from the calendar. 

3.  The meeting cancellation notice is automatically moved to the Deleted 
Items folder. 
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Working with Recurring Meetings 

Like appointments and events, meetings can be made to recur on a 
regular basis, such as weekly or monthly.  Recurring meetings are 
created, edited and modified, and deleted in the same manner as 
recurring appointments. 
 
Recurring meetings will have the recurring symbol next to the subject of 
the meeting in the calendar. 
 

 
 
Please refer to the topics Creating a Recurring Appointment, Editing a 
Recurring Appointment, and Deleting a Recurring Appointment in 
Chapter 2 – Working with Appointments of this manual for the specific 
procedures. 
 
For meeting organizers, when creating a recurring meeting, choose New 
Recurring Meeting instead of New Recurring Appointment. 
 
For meeting attendees, attendance at recurring meetings is the same as 
regular meetings.  Attendance at a single occurrence or the entire meeting 
series can be modified using the previously outlined procedures. 
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Chapter 5 
Using Calendar Coloring 

 

 
Chapter Objectives: 

•  Assigning Color to Calendar Items 

•  Editing the Calendar Coloring Labels 

•  Assigning Color Automatically 
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Overview 

A new feature of Outlook XP is the ability to use color as a tool to identify 
appointments, meetings, and events.  The easiest way to assign color to a 
calendar item is to use the Label drop-down list in the item window.   
 
The labels can be customized to suit an individual users’ needs.  Each 
item can have only one label, but exceptions can be used to apply a color 
to individual item in a series that is different from the default color of the 
series. 
 
Rules can also be created that direct Outlook to assign color and labels 
automatically based on the criteria specified by the user. 
 

Assigning Color to Calendar Items 

Calendar items can be colored with one of 10 predefined colors, each of 
which has a corresponding text label.  The default label choices are: 
 

• Important 
• Business 
• Personal 
• Vacation 
• Must Attend 
• Travel Required 
• Needs Preparation 
• Birthday 
• Anniversary 
• Phone Call 

 
Color can be assigned to a calendar item when it is created via the Label 
drop-down list box, it can be added later using the Calendar Coloring 
button on the Calendar toolbar, or it can be added using the pop-up 
menu. 
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Procedure:  (To assign color using the Label drop-down list) 

1.  Open the calendar item.  The corresponding window displays: 

 

 

2.  Select the Label drop-down list and choose a label name and color. 

3.    Click the Save and Close button on the toolbar.  
Outlook displays the calendar item with the selected background color. 
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Procedure:  (To assign color via the Calendar Coloring toolbar 
button) 

1.  Select the calendar item in the calendar. 

2.    Click the Calendar Coloring button on the Calendar toolbar.  The 
Calendar Coloring menu displays: 

 

 

3.  Choose the desired label and color.  Outlook changes the background of 
the calendar item to the selected color. 
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Procedure:  (To assign color via the pop-up menu) 

1.  Select the calendar item by right-clicking its left border.  A pop-up menu 
displays: 

 

 

2.  Select the Label menu.  The color choices display. 

3.  Select a label and color.  Outlook changes the background of the 
calendar item to the selected color. 

 

 
Tips: 

•  The color choices on the Calendar Coloring menu will be dimmed if no 
calendar item is selected. 

•  Color can be removed by choosing None from the menu. 

•  Meeting organizers can assign color to a meeting, however, it will not be 
received by the meeting attendees. 
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Editing the Calendar Coloring Labels 

While the number and choice of colors is limited, Outlook does allow 
customization of the text of the individual color labels. 
 

 
Procedure: 

1.    Click the Calendar Coloring button on the Calendar toolbar.  The 
Calendar Coloring drop-down menu displays. 

2.  Choose Edit Labels.  The Edit Calendar Labels dialog box displays: 

 

 

3.  Choose a label to modify by clicking in the field.  Delete the displayed 
text and type the new label. 

4.  Repeat step 3 for all labels to be modified. 

5.  Click OK when completed. 
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Warnings: 

•  When using the Edit Labels feature to change the text for a label, be 
sure to keep a list of the original label text and the new text.  Outlook 
does not have a “restore” or “reset” feature to return the list to its default.  
The original or default list can be found at the beginning of this chapter.  

•  When grouping or filtering based on the Label field in a table-based 
calendar view, Outlook will ignore the customized label text and 
continue to present the original default label text.  However, the 
placement of the label in the list remains the same. 

For example, in the appointment below, the label displays the 
customized text of Training Classes: 

 

 

 However, if the calendar is in a table view, the group and column display 
the original label of Personal: 
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Assigning Color Automatically 

Outlook also allows the creation of rules to automatically color 
appointments that meet established criteria.  For example, a specific color 
could be applied to all meeting requests from a particular person. 
 
Manual coloring always takes precedence over automatic coloring, so if 
manual coloring has been applied to an item, automatic coloring will not 
be applied to it. 
 

 
Procedure: 

1.    Click the Calendar Coloring button on the Calendar toolbar.  The 
Calendar Coloring drop-down menu displays: 

 

 

2.  Choose Automatic Formatting.  The Automatic Formatting dialog 
box displays: 
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3.  Click Add to add a new rule.   

4.  The Name field will be highlighted with the word Untitled in the field.  
Type a new name for the rule. 

5.  From the Label drop-down list, choose a label color and name. 

6.  Click Condition to create the conditions for when the color rule should 
be applied.  The Filter dialog box displays: 
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7.  Using the fields and tabs in the Filter dialog box, create the condition(s) 
for the rule. 

8.  Click OK to close the Filter dialog box. 

9.  If desired, click Add to create another rule and repeat steps 4 through 8. 

10.  Click OK to close the Automatic Formatting dialog box. 
 

 
Warning: 

•  Outlook maintains separate Automatic Formatting rules for every 
calendar view.  Therefore, when automatic formatting rules are created, 
they will only be applied in the view in which they were created.  For 
example, if an automatic formatting rule is created in the 
Day/Week/Month view (the default calendar view), that rule will not be 
present or applied in any other view, such as Day/Week/Month with 
AutoPreview. 
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Chapter 6 
Managing Group Schedules  

 

 
Chapter Objectives: 

•  Creating a Group Schedule 

•  Adding a Distribution List to a Group Schedule 

•  Viewing a Group Schedule 

•  Editing or Modifying a Group Schedule 

•  Setting up a Meeting or Sending E-mail using a Group Schedule 

•  Deleting a Group Schedule 
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Overview 

Previous chapters explained how to use Outlook to set up appointments 
and meetings.  However, there is an additional tool for planning and 
scheduling meetings: Group Schedules.  Because all user calendar 
information is stored in a single database, users have easy access to the 
calendars for all members of the organization. 
 
For example, managers can get an overview of what their teams are doing 
by viewing the team members’ joint schedules, or an administrative 
assistant who needs to locate employees can check a group schedule for 
Outlook calendars. 
 
A group schedule allows anyone to view other calendars without having to 
go through the process of scheduling a meeting.  It should be noted 
however that the availability information will be generic, unless the other 
users have granted additional permissions to their calendars. 
 
This chapter will show how to create and manage group schedules, as 
well as how to use group schedules to perform such tasks as e-mailing a 
group of users and scheduling meetings. 
 

Creating a Group Schedule 

Group schedules can be thought of as “distribution lists” for calendars.  
Distribution lists consist of e-mail addresses under a single title or name, 
while group schedules consist of multiple calendars under a single title or 
name. 
 
Creating a group schedule is very similar to the process of scheduling a 
meeting.  The group schedule window is almost exactly the same as the 
Meeting Planner window.  See Chapter 4 – Working with Meetings for a 
complete description of the Meeting Planner window. 
 

 
Procedure: 

1.  Select the Actions menu and choose View Group Schedules. 

 OR 

   Click the Schedules button on the Calendar toolbar.  The 
Group Schedules dialog box displays: 
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2.  Click New.  The Create New Group Schedule dialog box displays: 

 

 

3.  Type a descriptive name for the group schedule and click OK.  The 
group schedule window displays: 
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4.  To add names from the Global Address List to the schedule, click Add 
Others and choose Add from Address Book. 

 

 

 The Select Members dialog box displays: 
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5.  Choose members by scrolling, highlighting the name(s), and clicking To.  
Click OK when all members have been selected.  Outlook displays the 
group schedule window with the selected members and their availability 
information: 

 

 

6.  Click Save and Close to save the member list and close the group 
schedule. 
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Adding a Distribution List to a Group Schedule 

Outlook distribution lists can also be added to group schedules.  This can 
be used as a shortcut for adding an already existing list of people to a 
group schedule, or as a convenient way to display multiple schedules on 
one line. 
 

 
Procedure: 

1.  Select the Actions menu and choose View Group Schedules. 

 OR 

   Click the Schedules button on the Calendar toolbar.  The 
Group Schedules dialog box displays. 

2.  Select a schedule and click Open.  The selected group schedule 
window displays. 

3.  Click Add Others and choose Add from Address Book.  The Select 
Members dialog box displays: 

 

 

4.  Select the distribution list name and click To. 
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5.  Click OK to return to the group schedule. 

6.  The list name will appear in the Group Member list with a plus sign [+] 
next to the name of the list. 

 

 

7.  If desired, click the plus sign [+] to expand the list into its individual 
member names.  The Expand List warning displays: 

 

 

8.  Click OK to proceed.  Outlook expands the list into the individual 
member names and displays their calendars: 
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9.  Click Save and Close to save changes and close the group schedule 
window. 

 

 
Tip: 

•  To not be warned in the future when expanding a list, select the Please 
do not show me this dialog again check box. 
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Viewing a Group Schedule 

A group schedule can be viewed at any time.  For example, viewing a 
group schedule can be used to help get an idea of when to plan a 
meeting, or it could be used to see which team members are currently in 
the office. 
 
The group schedule window is nearly identical to the Plan a Meeting 
window or the Scheduling tab in a meeting invitation.  See the topic 
Understanding the Meeting Planner Window in Chapter 4 – Working 
with Meetings for a complete description of the window features and 
options. 
 

 
Procedure: 

1.  Select the Actions menu and choose View Group Schedules. 

 OR 

   Click the Schedules button on the Calendar toolbar.  The 
Group Schedules dialog box displays: 

 

 

2.  Choose a group schedule and click Open.  The selected group schedule 
displays: 
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3.  Click Save and Close when finished viewing the calendar. 
 

 
Tips: 

•  Instead of using the scroll bars, use the Go to drop-down box to choose 
a different date. 

•  The amount of detail shown for each member’s calendar will depend 
upon the permissions that the member has granted for specific 
individuals or groups.  If the member has not granted any permission, no 
calendar details will be available, regardless of the setting of the Show 
Calendar Details option. 

•    If adequate permission has been granted, any member’s calendar 
can be viewed in a separate window by clicking the Open Folder icon in 
the left-hand column next to the member’s name. 

•  There are no Start and End bars or AutoPick in a group schedule. 
 



Chapter 6 – Managing Group Schedules 

Page 118  © 0A316 

Editing or Modifying a Group Schedule 

A group schedule can be edited or modified at any time.  For instance, a 
user may wish to add or remove a people from the group schedule. 
 

 
Procedure: (To add members to the group schedule) 

1.  Open the group schedule to be modified. 

2.  In the group schedule window, click Add Others and choose Add from 
Address Book.  The Select Members dialog box displays. 

3.  Choose additional members by scrolling, highlighting the name(s), and 
clicking To.   

4.  Click OK when all members have been selected. 

5.  Outlook displays the group schedule window with the added members 
and their availability information. 

6.  Click Save and Close to save the changes and close the Group 
Schedule window. 

 

 
Procedure: (To remove members from a group schedule) 

1.  Open the group schedule to be modified. 

2.  Click the member name to activate the listing, then click the member 
name again to highlight it and then press the [Delete] key. 

 OR 

 Right-click the member name and select Clear. 

3.  The member’s name is removed from the list.  Repeat step 2 for 
additional names. 

4.  Click Save and Close to save the changes and close the Group 
Schedule window. 
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Setting up a Meeting or Sending E-mail Using a Group Schedule 

A group schedule can be used as a starting point for setting up a meeting 
or sending an e-mail message.  When choosing one of these options, 
Outlook opens a new meeting request window or a message window and 
the meeting request or the message is created as normal. 
 

 
Procedure: (To send an e-mail to a group schedule) 

1.  Open the desired group schedule. 

2.  Click Make Meeting.  A drop-down menu displays: 

 

 

3.  Choose New Mail Message with All.  A Message window with the 
member addresses and the group schedule name as the Subject 
displays: 
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4.  Change the subject if desired and compose the message. 

5.    Click the Send button on the Message toolbar to send the 
message. 

6.  Click Save and Close to close the group schedule window. 
 

 
Tip: 

•  To send a message to a single member of the list, first select any time 
block of the member’s calendar, then click the Make Meeting drop-
down menu, and choose New Mail Message. 

 



Chapter 6 – Managing Group Schedules 

© 0A316  Page 121 

 
Procedure: (To create a meeting with the members of a group 
schedule) 

1.  Open the desired group schedule. 

2.  Using the mouse, drag over the desired meeting date and time in the 
planner on one member’s calendar (it does not matter whose calendar is 
selected).  Outlook will highlight the time block with a solid black border. 

 

 

3.  Click Make Meeting.  A drop-down menu displays: 
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4.  Choose New Meeting with All.  A Meeting window with the group 
members in the To field displays: 
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5.  Fill out the rest of the meeting fields as desired (See the table in 
Chapter 4 – Working with Meetings for a complete description of 
these fields). 

6.  Click Send to send the meeting invitation. 

7.  Click Save and Close to close the group schedule window. 
 

 
Tips: 

•  To create a meeting with a single member of the list, select the desired 
date and time block in that member’s calendar, click the Make Meeting 
drop-down menu, and choose New Meeting. 

•  To cancel the creation of a meeting, Close the meeting invitation 
window without saving changes. 
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Deleting a Group Schedule 

If it is no longer needed, a group schedule can be deleted from Outlook. 
 

 
Procedure: 

1.  Select the Actions menu and choose View Group Schedules. 

 OR 

   Click the Schedules button on the Calendar toolbar. 

2.  Select a group schedule and click Delete.  The Delete Group Schedule 
dialog box displays: 

 

 

3.  Click Yes to permanently delete the group schedule.  Click No to cancel 
and return to the group schedule list. 

 

 
Warning: 

•  Once deleted, a group schedule cannot be recovered with the Undo 
command, nor will it be present in the Deleted Items folder. 
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Chapter 7 
Sharing Calendars 

 

 
Chapter Objectives: 

•  Viewing Another User’s Calendar 

•  Designating a Delegate 

•  Granting Access Permission to a Calendar 

•  Marking a Calendar Item as Private 

•  Forwarding Calendar Items to Local Users 

•  Forwarding Calendar Items to Outside Users 

•  Publishing a Calendar as a Web Page 
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Overview 

Outlook has many powerful features for sharing calendars and calendar 
items between users in a network environment.  This access is granted 
not by system administrators, but by the calendar author and users 
themselves.  This allows users to individually customize the access to 
their calendar without having to involve a system administrator. 
 
Users can be designated as delegates, which will give them access 
permission to the calendar and send on behalf permissions, or a calendar 
author can grant simple read permission to a group of users. 
 
Calendar items can also be forwarded as attachments to both local users 
and, using the iCalendar standard, to users on the Internet. 
 
This chapter will cover how to view the calendars of other Outlook users, 
create delegates, grant calendar permissions, and how to forward 
calendar items to both local and outside users. 
 

Viewing Another User’s Calendar 

Outlook offers the ability to view another user’s or another resource’s 
calendar and meeting rooms.  Unlike a group schedule, this feature opens 
a full calendar window that can be browsed and navigated. 
 
First it is necessary that the calendar is open to the public, or that the user 
otherwise has access to it, by way of delegates or permissions.  Viewing 
another calendar can help determine available meeting times, as well as 
check the availability of meeting rooms and equipment. 
 

 
Procedure: 

1.  Select the File menu, choose Open, then Other User’s Folder.  The 
Open Other User’s Folder dialog box displays: 

 

 

2.  Click Name.  The Select Name dialog box displays: 
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3.  Select the name from the Type Name or Select from List area and 
choose OK.  The Open Other User’s Folder dialog box displays with 
the selected name: 

 

 

4.  Verify that the Folder selected is Calendar.  If it is not, use the drop-
down list to select it. 

5.  Click OK when complete.  The calendar for the selected user or 
resource displays as a separate window: 
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6.  If the user does not have rights to view the calendar, the following dialog 
box displays: 

 

 
 

 
Tip: 

•  Rights to view a calendar are granted by the calendar owner.  Check 
with that user if access is needed or required. 

•  Calendars that have been previously opened will appear on the File, 
Open submenu.  Select a calendar from the list and click to open the 
calendar without having to complete all the steps in this procedure. 
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Designating a Delegate 

A delegate is another user who has been given complete access to a 
calendar.  For instance, a manager can make their administrative 
assistant a delegate so that the delegate can administer the calendar on 
the manager’s behalf. 
 
Delegates can also be configured to receive and answer all meeting 
requests from other users.  The delegate will then receive meeting 
requests and manage the responses. 
 

 

 

Procedure: 

1.  Select the Tools menu and choose Options. 

2.  Select the Delegates tab. 

 

 

3.  Click Add.  The Add Users dialog box displays: 
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4.  Select a user and click Add. 

5.  Click OK.  The Delegate Permissions dialog box displays: 
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6.  In the Calendar drop-down list, select one of the following permission 
levels for the delegate: 

 

Option Description 

None Delegate does not have any permission to the folder. 

Reviewer Delegate can only read items in the folder. 

Author Delegate can read items and create new items, but cannot 
modify, change, or delete existing items  

Editor Delegate can read items, create new items, make 
changes, and delete any items. 

 

7.  Select any of the following additional options: 
 

Option Description 

Delegate receives copies of 
meeting-related messages sent to 
me 

The delegate will receives copies of all 
meeting invitations, updates, and 
cancellations.  Only available if the 
permission level is set to Editor. 

Automatically send a message to 
delegate summarizing these 
permissions 

Select this check box to have Outlook send 
an e-mail to the delegate with a summary of 
the permissions granted. 

Delegate can see my private items The delegate will be able to read and view 
any items that have been marked as Private.

 

8.  Click OK when completed.  The Options window displays: 
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9.  If the delegate was granted Editor permission to the calendar, the Send 
meeting requests and responses only to my delegates, not to me 
check box will be enabled.  Select this check box to have all meeting-
related e-mails be sent ONLY to the delegate. 

10.  Click OK when completed. 
 

 
Tip: 

•  The recipient of a meeting request created by a delegate sees the 
message as coming from the calendar’s owner, not the delegate.  When 
the recipient opens the message, however, the header indicates that the 
message was sent by the delegate on behalf of the owner.  Responses 
to the meeting request come back to the delegate and a copy goes to 
the owner, unless the Send meeting requests and responses only to 
my delegates, not to me option has been enabled. 
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Granting Access Permission to a Calendar 

There may be times when designating a delegate is “overkill” – that is, the 
user being granted permission to the calendar may not need all the extra 
options that being a delegate affords.  Or a calendar owner may not want 
other users to have too much access to their calendar. 
 
In these cases, a user can grant a certain level of access permission to 
their calendar, so that others can access the calendar, but not perform any 
other special functions unless granted by the owner. 
 
Also, if the calendar owner wishes to grant a large number of people 
access to their calendar, it is better to set access permissions than to 
create a lengthy list of delegates.  For instance, the calendar owner can 
grant read access to all members of their department. 
 

 
Procedure: 

1.  From the File menu, select Folder, then from the submenu select 
Properties for “Calendar” 

 OR 

 Right-click the calendar folder in the folder list and select Properties.  
The Calendar Properties dialog box displays. 

2.  Select the Permissions tab. 



Chapter 7 – Sharing Calendars 

© 0A316  Page 135 

 

 

3.  Click Add.  The Add Users dialog box displays: 
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4.  Select a user name or names, or distribution list, and click Add. 

5.  Click OK when completed.  The Name list of the Permission tab 
displays the added user, users, or distribution list with a Permission 
Level of None. 
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6.  Select a Name in the list and assign a Permission Level from the drop-
down list.  The following table describes the access granted for each 
Permission Level: 

 

Option Description 

Owner The user has all permissions and can edit and delete all 
items, including those they do not own. 

Publishing Editor The user has all permissions and can edit and delete all 
items but does not own the folder. 

Editor The user has all permissions except the ability to create 
subfolders or act as the folder’s owner.  Editors can edit 
and delete all items. 

Publishing Author Has all permissions except the ability to edit or delete 
items belonging to others and has the ability to act as the 
folder’s owner. 

Author This level is the same as Publishing Author except Authors 
can’t create subfolders. 

Nonediting Author Users can create and read items and delete items they 
own, but they can’t delete others’ items or create 
subfolders. 

Reviewer Users can view items but can’t modify or delete items or 
create subfolders. 

Contributor Users can create items but not view or modify existing 
ones. 

None The folder is visible but users can’t read, create, or modify 
any items in the folder. 
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7.  If none of the predefined Permission Levels are satisfactory, create a 
custom set of permissions using the check boxes and option buttons.  
The following table lists what each permission allows a user to do: 

 

Option Description 

Create Items User can post items to the folder. 

Read Items User can read items in the folder. 

Create Subfolders User can create additional folders inside the folder. 

Folder Owner The owner has all permissions for the folder. 

Folder Contact The folder contact receives automated messages from the 
folder such as requests from users for additional 
permissions and other changes to the folder status. 

Folder Visible User can see the folder. 

Edit Items User can edit all items or only those items they own. 

Delete Items User can delete all items or only those items they own. 

 

8.  Click OK when completed. 
 

 
Tip: 

•  To revoke a user’s permission, select their name in the Permissions 
tab and click Remove. 

•  It may be necessary for both the user granting permission and the user 
receiving permission to exit Outlook and start again in order for the 
permissions to take effect. 
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Marking a Calendar Item as Private 

Marking an appointment or meeting as private will make the description of 
that item unavailable to all users except the author.  This allows the author 
to have items on their calendar that cannot be read by delegates or other 
users with read permission. 
 

 

 

Procedure: 

1.  Create a new calendar item and fill out the required fields or open an 
existing item. 

2.  Check the box labeled Private. 

 

3.    Click the Save and Close button on the item toolbar. 
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Forwarding Calendar Items to Local Users 

Any calendar item can be forwarded to another local user so that they can 
add it to their calendar.  This is not the same as creating a meeting.  With 
a meeting, the calendar items of the meeting organizer and attendees are 
“connected”.  When forwarding, a copy of the item is sent to the 
destination user and there is no connection between the original and the 
copy. 
 
Forwarding calendar items works well for situations such as classes, 
workshops, or parties where the list of attendees may be constantly 
changing.  The organizer of the event can simply forward a calendar item 
to each attendee at the time of their sign up, which the attendee can then 
add to their own calendar.  However, if the event is cancelled, each user 
will have to remove the item from their calendar individually. 
 
The forwarded item inherits all the properties and settings of the original 
calendar item.  For instance, if the item had a 30-minute reminder set, the 
forwarded item will have a 30-minute reminder as well. 
 
When a forwarded calendar item is received, it can easily be added to the 
calendar. 
 

 
Procedure: (To forward a calendar item) 

1.  Right-click the calendar item and choose Forward. 

 OR 

 Select the calendar item.  Select the Actions menu and choose 
Forward. 

 OR 

 Select the calendar item.  Press [Ctrl] + [F].  A forward e-mail window 
displays with the calendar item as an attachment in the message: 
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2.  Select the user or users to receive the message.  The item can be 
forwarded to a single user, multiple users, or a distribution list. 

3.  Type a message and/or add any other e-mail options as desired. 

4.    Click Send on the e-mail toolbar when completed. 
 

 
Procedure: (To add a forwarded item to the calendar) 

1.  Open the message containing the calendar item or view it in the 
Preview Pane. 

2.  Drag the icon in the message to the Calendar icon on the Outlook 
shortcut bar. 

 OR 

 Drag the icon in the message to the Calendar folder in the folder list. 
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3.  When the plus sign appears next to the pointer, release the mouse. 

4.  The calendar item will be added to the calendar. 
 

 
Tip: 

•  To view the details of the item before adding it to the calendar, double-
click the icon in the message.  The item will open as a separate window.  
Close the item window before adding the item to the calendar. 
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Forwarding Calendar Items to Outside Users 

Outlook users can share calendar items with others who are not on the 
local e-mail system or with people do not use Outlook.  Outlook offers two 
formats for exchanging calendar items – iCalendar and vCalendar.   
 
iCalendar and vCalendar are internet-based standards for exchanging 
calendar information between people who use different calendaring 
programs.  iCalendar is essentially a newer version of vCalendar and 
should be the first choice when sending calendar items to Internet users. 
 

 
Procedure:  (To forward an iCalendar item) 

1.  Select or Open the calendar item to be sent. 

2.  Select the Actions menu and choose Forward as iCalendar.  A 
Message window with the calendar item as an attachment displays: 

 

 

3.  Enter the recipient’s Internet e-mail address and set any other message 
options as desired. 

4.    Click Send on the Message toolbar when completed. 
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Publishing a Calendar as a Web Page 

Another method for allowing users who are not running Outlook or are 
outside the local e-mail system to view a calendar is to save it as Web 
page.  The calendar can be saved to any Web server using FTP, and to 
some servers using HTTP. 
 
The Save as Web Page feature creates a very functional online calendar 
that can be easily viewed with any web browser, without requiring any 
knowledge of HTML, a common web page language. 
 

 
Procedure: 

1.  From the calendar folder, select the File menu and choose Save as 
Web Page.  The Save as Web Page dialog box displays: 

 

 

2.  Use the following table to complete the options is this dialog box: 
 

Option Description 

Start/End date Use the drop-down boxes to select the date range for the 
calendar to be published. 

Include appointment 
details 

Select this check box to publish the details of the calendar 
items’ Notes area with the calendar. 
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Option Description 

Use background 
graphic 

Select this option to use an image as a background for the 
calendar.  Type a pathname to the file in the box, or click 
Browse to select an image file. 

Calendar title Enter a name or title for the calendar that will appear at the 
top of the web browser.  Defaults to the user’s name. 

File name Type a path name or click Browse to select the directory 
where the web page(s) should be saved.  This can either 
be a local or network directory, or a web or FTP server. 

Open saved web page 
in browser 

Displays the resulting calendar output in the default web 
browser. 

 

3.  When all desired options have been selected, click Save. 

4.  Outlook creates the calendar HTML files, and if selected, displays the 
calendar in the web browser: 

 

 



Chapter 7 – Sharing Calendars 

Page 146  © 0A316 

5.  When finished previewing, Close the web browser. 
 

 
Tip: 

•  The Save as Web Page dialog box will remember the previous settings 
used.  This makes it easy to publish calendars on a regular basis 
without having to re-enter all of the options. 

•  Once displayed in the web browser, click any date to have the 
Appointment and Event Details list scroll to that date’s details. 

 

 
Warning: 

•  The calendar created by this method is not dynamic, that is, if changes 
are made to the Outlook calendar, the web version will have to be 
created again with the new details and uploaded again to the server. 
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Chapter 8 
Printing Calendars 

 

 
Chapter Objectives: 

•  Printing Individual Calendar Items 

•  Printing in Calendar-Based Views 

•  Printing in Table-Based Views 

•  Changing the Page Setup Options 

•  Creating a Custom Print Style 

•  Deleting a Print Style 

•  Resetting a Print Style 
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Overview 

Many people work in Outlook and never print any of the items in the 
calendar.  For others, the ability to print calendars and individual items is 
important, such as for use in a day planner or appointment book. 
 
The type of printout that can be created depends on the initial view of the 
calendar.  The following table lists the default views for the calendar, the 
view type, and the print styles available for each view. 
 

View Name View Type Available Print Styles

Day/Week/Month  
Day/Week/Month with 

AutoPreview 

Calendar Daily, Weekly, 
Monthly, Tri-Fold, 
Calendar Details 

Active Appointments 
Events 

Annual Events 
Recurring Appointments 

By Category 

Table Table, Memo 

 
This chapter examines the options and methods for printing calendars, 
appointments, and meetings.  It also explains how to customize the print 
styles provided by Outlook to create custom styles to suit an individual’s 
preferences or needs.  
 

Printing Individual Calendar Items 

Any individual calendar item, such as an event, appointment, or meeting, 
can be printed.  Individual items are printed in memo style.  Each item 
must be selected and printed separately. 
 
Multiple individual items can be printed at once, however, a table-based 
view (see table above) must be selected first.  See Printing in Table-
Based Views later in this chapter for more information. 
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Procedure:  (To print one copy of an item to the default printer) 

1.  Right-click the item and select Print from the pop-up menu. 

 OR 

   Open the item and click the Print button on the item toolbar. 

 OR 

 Open the item, select the File menu, choose Print, and then click OK. 

2.  One copy of the item will be printed to the default printer. 

3.  Close the item if necessary. 
 

 
Procedure:  (To access the Print dialog box and set options) 

1.  Open the item to be printed. 

2.  Select the File menu and choose Print.  The Print dialog box displays: 
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3.  To select a printer other than the default printer, select the Name drop-
down list in the Printer area and choose a printer. 

4.  In the Print style area, click Page Setup to access options for the 
appearance of the printout.  (See the Changing the Page Setup 
Options topic in this chapter for more information.) 

5.  In the Copies area, select the number of copies to be printed. 

6.  In the Print Options area, select the Print attached files check box if 
any item attachments should be printed. 

7.  To preview the printout, click Preview.  Click the Print button on the 
Print Preview toolbar to return to the Print dialog box. 

8.  Click OK to print the item. 
 

 
Tips: 

•  Memo style is the only option for printing individual calendar items, 
however, custom print styles can be created based on the memo style 
and saved in the Print style list.  See Creating a Custom Print Style 
later in this chapter for more information. 
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Printing in Calendar-Based Views 

Printing in a calendar-based view is the most common way to print in 
Outlook.  These printouts are the ones that most closely resemble 
traditional calendars.  Outlook offers several basic calendar print styles 
that can be customized to suit a variety of needs. 
 

 
Procedure: 

1.  Select a calendar-based view (see the table at the beginning of this 
chapter for the default calendar-based views). 

2.  Select the File menu and choose Print. 

 OR 

   Click the Print button on the Calendar toolbar.  The Print dialog 
box displays: 

 

 

3.  To select a printer other than the default printer, select the Name drop-
down list in the Printer area and choose a printer. 
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4.  Select a Print style.  This list will default to the style that most closely 
matches the current calendar view, however, any style can be selected.  
The following table describes the built-in print styles: 

 

Print Style Description 

Daily Prints one day per page. 

Weekly Prints one work week (as defined in the calendar Options) 
per page. 

Monthly Prints five weeks in a month style per page starting with 
the week of the selected start date. 

Tri-Fold Divides the page into three sections (left, middle, and 
right).  Defaults to a Daily calendar on the left, a TaskPad 
in the middle, and a Weekly calendar on the right. 

Calendar Details Prints calendar items with their full details as a running list 
with daily group headers. 

 

5.  If desired, click Page Setup to access options for the appearance of the 
printout.  (See the Changing the Page Setup Options topic in this 
chapter for more information.) 

6.  In the Print Range area, use the Start and End drop down menus to 
select the date range to be printed. 

7.  In the Copies area, select options for the number of copies, what pages 
should print (all, even, odd), and if multiple pages should be collated. 

8.  To view a preview of the printout, select Preview.  The Print Preview 
window displays: 
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9.  Click the Print button on the Print Preview toolbar to return to the Print 
dialog box. 

10.  Click OK to print. 
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Printing in Table-Based Views 

Printing in a table-based view is ideal when a list of calendar items of a 
particular type is desired.  Table-based views are also the only way to 
print multiple individual items without having to select them one at a time. 
 
When printing in a table-based view, only the Table and Memo print styles 
are available.  The Table print style prints items in rows with column 
headings, similar to a Word table or Excel spreadsheet.  The Memo print 
style prints the entire contents of an item before printing the next item, 
similar to printing records in Access. 
 

 
Procedure: 

1.  Select a table-based calendar view (see the table at the beginning of 
this chapter for the default table-based views). 

2.  If desired, hold down the [Ctrl] or [Shift] keys and click with the mouse 
to select individual items to be printed. 

3.  Select the File menu and choose Print. 

 OR 

   Click the Print button on the Calendar toolbar.  The Print dialog 
box displays: 
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4.  Select either the Table or Memo print style. 

5.  If the Table print style is selected, select either All rows in the Print 
Range area to print all items in the list, or select Only selected rows to 
print only the items that were selected in step #2. 

6.  If the Memo print style is selected, select the Start each item on a new 
page check box to have each item in the table printed on a separate 
sheet of paper, or uncheck the box to have multiple items printed on a 
page.  Select the Print attached files check box to additionally print any 
attachments that the calendar items may have. 
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7.  If desired, click Page Setup to access options for the appearance of the 
printout.  (See the Changing the Page Setup Options topic in this 
chapter for more information.) 

8.  Select any other Printer and Copies options as desired. 

9.  To view a preview of the printout, click Preview.  Click the Print button 
on the Print Preview toolbar to return to the Print dialog box. 

10.  Click OK to print. 
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Changing the Page Setup Options 

In all print styles, Outlook offers the ability to customize the printout that is 
created.  The Page Setup dialog box has three main tabs – Format, 
Paper, and Header/Footer.  The Paper and Header/Footer tabs are the 
same for every print style, however, the Format tab will offer different 
options for each print style. 
 
If the page setup options are changed for a particular print style, those 
settings are maintained by Outlook for subsequent printings.  For instance, 
if the Daily style is changed from portrait to landscape orientation, it will 
always print as landscape until it is reset or changed again. 
 
The Page Setup dialog box also plays a key role in creating custom print 
styles as described later in this chapter. 
 
The following procedure describes how to access the page setup options.  
The subsections describe each tab and its parts in detail. 
 

 
Procedure: 

1.  Open the Print dialog box as described in the previous procedures. 

2.  Click Page Setup. 

3.  Using the Format, Paper, and Header/Footer tabs, select the desired 
print options. 

4.  Click OK or Print to return to the Print dialog box, or click Print 
Preview to view a preview. 

5.  Click OK in the Print dialog box to print. 
 

 
Tip: 

•  Due to the number of options for print styles, it is recommended that 
Print Preview be used before printing to determine if the printout 
contains the correct and/or desired options.  Click the Page Setup 
button on the Print Preview toolbar to return to the dialog box if needed 
to make changes. 
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The Format Tab 

This tab controls what elements should appear on a printout and what 
fonts should be used.  It contains three sections – Options, Fonts, and 
Shading.  The Format tab of the Daily Style is pictured below. 
 

 
 

Section Description 

Options In calendar-based print styles (Daily, Weekly, 
Monthly, etc.) this section will have different 
options available for every print style.  Use the 
available drop-down lists and check boxes to 
customize the printout.  The Table and Memo print 
styles do not have any options in this section. 

Fonts Select the font for a particular section.  This area 
will have different options dependent on the 
selected print style. 

Shading Select this check box to have light gray shading 
added to headings, dates, and other elements.   
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The Paper Tab 

This tab controls the settings for the paper that the printout will appear on 
and the page layout. 
 

 
 

Section Description 

Paper Select a paper size from the Type box, or select 
Custom and then input the paper Width and 
Height in the Dimensions area.  Use the Paper 
Source drop-down list to select a different paper 
tray on the printer (if available). 

Page Specifies the page layouts and sizes available for 
the paper selected in the Type box. 

Margins Use these boxes to set the top, bottom, left, and 
right margins for the printout. 

Orientation Selects the orientation of the paper – Portrait or 
Landscape.  Also displays a preview of the page 
layout based on the Paper and Page settings. 
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The Header/Footer Tab 

This tab contains options for the header and footer of a printout.  Both the 
header and the footer are constructed in the same manner, with sections 
for the left side, middle, and right side.  The tab has the same options for 
all print styles. 
 

 
 

Section Description 

Header/Footer Use the Font button to set a font for the text.  Any 
text can be typed in the left, middle or right boxes, 
as well as automatic text can be inserted by using 
the insert buttons. 

Insert Buttons Use these buttons to automatically insert text into a 
header or footer.  Left to right these buttons are 
Page #, Total Pages, Date Printed, Time Printed, 
and Username. 

Reverse on even 
pages 

Select this option to have the headers and footers 
reversed on even-numbered pages, i.e. on an even-
numbered page the left sections will appear on the 
right and the right sections on the left. 
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Creating a Custom Print Style 

Outlook provides a broad range of print styles for calendars, so it is likely 
that one of the styles will fit most printing needs.  When these print styles 
don’t quite offer what is needed, a custom print style can be created. 
 
Outlook offers two methods for creating custom print styles – modifying an 
existing print style, or copying a style and then modifying the copy to 
incorporate the changes needed. 
 
If the same modifications are always made to a particular print style, it 
would be best to simply modify that existing style rather than create a new 
one.  If the default style is used occasionally but its properties are modified 
for most other print jobs, consider creating a custom print style based on 
the existing one so that both are available. 
 

 
Procedure: 

1.  Select the File menu and choose Print.  In the Print dialog box, click 
Define Styles. 

 OR 

 Select the File menu, choose Page Setup, then Define Print Styles.  
The Define Print Style dialog box displays: 

 

 

2.  Select a print style from the list. 

3.  To create a new style based on an existing style, click Copy.  To modify 
an existing style, click Edit.  The Page Setup dialog box displays: 
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4.  If the style is a copy, enter a new Style name, otherwise this option will 
be dimmed. 

5.  Using the Format, Paper, and Header/Footer tabs, set the other print 
style options as desired.  See Changing the Page Setup Options in 
this chapter for more information on the available options. 

6.  Click OK when completed. 

7.  If a new style was created it will now appear in the Define Print Styles 
list.  It will also be available in the Print style list of the Print dialog box. 
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New print style in the Define Print Styles dialog box 

 

 

New print style listed in the Print style area of the Print dialog box 

8.  Click Close to close the dialog box and (if open) return to the Print 
dialog box. 



Chapter 8 – Printing Calendars 

© 0A316  Page 165 

Deleting a Print Style 

If custom print styles have been created but are no longer used or 
needed, they can be deleted from the print style list.  
 

 
Procedure: 

1.  Open the Define Print Styles dialog box as described in the previous 
procedure. 

2.  Select the print style to be deleted and click Delete.  The following 
message displays: 

 

 

3.  Click OK to delete the style or Cancel to keep it. 

4.  Click Close to close the Define Print Styles dialog box. 
 

 
Warning: 

•  Once deleted, a custom print style cannot be recovered with the Undo 
command, nor will it be present in the Deleted Items folder. 
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Resetting a Print Style 

The standard print styles provided by Outlook cannot be deleted but they 
can be modified, either via the Page Setup settings or through the Define 
Styles option.  This presents a problem if the user wishes to return the 
print style to its original setup, but does not remember the original settings. 
 
Use the following procedure to have Outlook return a print style to its 
original default settings. 
 

 
Procedure: 

1.  Open the Define Print Styles dialog box as described previously. 

2.  Select the print style to be restored to its original settings and click 
Reset.  The following message displays: 

 

 

3.  Click OK to reset the style or Cancel to keep the modified settings. 

4.  Click Close to close the Define Print Styles dialog box. 
 

 
Warning: 

•  Once reset, custom print style settings cannot be recovered with the 
Undo command.  The custom settings will have be to be recreated. 

•  Since they are created by the user, custom print styles cannot be reset. 
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Chapter 9 
Customizing the Calendar 

 

 
Chapter Objectives: 

•  Setting Reminder Options 

•  Setting Calendar Options 

•  Setting the Planning Grid Options 

•  Adding Holidays as Events 

•  Setting Free and Busy Options 

•  Processing Meeting Requests Automatically 

•  Setting Time Zone Options 

•  Changing the Date Navigator Font 

•  Making Calendar the Default Outlook Folder 

•  Modifying a Calendar View 
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Overview 

Outlook’s calendar has an extensive number of options that can be set to 
control how it looks, behaves, and functions.  This allows each user to 
configure the calendar in a way that works best for them. 
 
This chapter will explore the many options users have available to them 
for configuring the calendar’s options, as well as some of the features 
relating to modifying the calendar views. 
 

Setting Reminder Options 

Reminders are a valuable tool when working with calendar, especially if a 
calendar has numerous appointments and meetings.  Outlook can be 
configured so that all appointments, meetings, and events have a default 
reminder set when creating an item.  This saves time when creating the 
item. 
 
This setting is the default that will be applied to a calendar item when it is 
created.  During the creation process, or at any time, the reminder for an 
item can be turned on or off, and/or the time can be changed. 
 
Additionally, the reminders have two advanced options to control what 
happens when they come due. 
 

 
Procedure: (To set the default reminder) 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays: 
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2.  In the Calendar section of the Preferences tab, select the Default 
reminder check box to enable reminders to be on by default when 
creating an appointment, event, or meeting.  Clear this check box to turn 
off default reminders. 

3.  In the drop-down list, select the amount of time prior to the start of an 
item that the reminder should appear, or type a time amount in the box. 

4.  Click OK when completed. 
 

 
Tip: 

•  When creating an item that occurs in the past, the reminder will be 
cleared and dimmed, regardless of the default setting. 
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Procedure: (To set advanced reminder options) 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays. 

2.  Select the Other tab. 

 

 

3.  Click Advanced Options.  The Advanced Options dialog box displays: 
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4.  Click Reminder Options.  The Reminder Options dialog box displays: 

 

 

5.  Select the Display the reminder check box to have Outlook display the 
Reminders window when reminders come due.  Clear this check box to 
prevent the window from displaying. 

6.  To have Outlook play a sound when a Reminder window displays, 
select  the Play reminder sound check box and click Browse to select 
a sound file.  Clear this check box to turn off the sound. 

7.  Click OK to confirm the changes and close each dialog box when 
completed. 
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Setting Calendar Options 

The following procedure and table give a general description of the 
options available for configuring the calendar found in the Tools, Options 
menu.  Further procedures in this chapter will go into more detail 
regarding several of the options found here. 
 

 
Procedure: 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays. 

2.  Click Calendar Options.  The Calendar Options dialog box displays: 

 

 

3.  Use the following table to set the options for the calendar: 
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Option Description 

Calendar Work Week  

 Days of the week check 
 boxes 

Select or clear the check boxes to specify which 
days of the week are work days. 

 First day of week Use the drop-down list to choose which day 
begins the work week. 

 First week of year Use the drop-down list to select the first week of 
the calendar year.  This option can be used for 
setting a calendar to correspond with a fiscal 
year, or other non-traditional calendars. 

 Start and End time Specify the start time and end time of the work 
day.  These drop-down lists change the 
appearance of the calendar notepad and the 
user’s availability for meetings. 

Calendar options  

 Show week numbers in 
 the Date Navigator 

Allows the user to display week numbers (1 
through 52) in the Date Navigator. 

 Allow attendees to 
 propose new times for 
 meetings you organize 

Allows meeting attendees the option to propose 
new times for meetings organized by the user.  
This setting can be changed in individual 
meeting requests. 

 Use this response when 
 you propose new meeting 
 times. 

Select from this drop-down to indicate what type 
of response should be made when proposing a 
new meeting time. 

 Background color Select from this drop-down a color for the 
calendar notepad background for working hours.

 Planner Options* Displays the planner options dialog box which 
controls options in the Meeting Planner and 
Group Schedules. 

 Add Holidays* Allows the user to add events to their calendar 
from over 1,000 holidays from around the world. 
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Option Description 

Advanced options  

 Enable alternate calendar Used to view and set options of calendar 
systems other than the Roman calendar. 

 When sending meeting 
 requests over the 
 Internet, use iCalendar 
 format. 

Specifies that Outlook should always use the 
iCalendar format when scheduling meetings with 
users over the Internet.  Can only be enabled 
when an Internet-based (POP3, IMAP, SMTP) 
e-mail account is added to Outlook. 

 Free/Busy Options* Sets the options for how much of the user's 
calendar is published to the server, and how 
often that information is uploaded to the server.  
Also controls internet free/busy publishing 
options. 

 Resource Scheduling* Allows Outlook to automatically accept or 
decline meeting requests for the user depending 
on availability. 

 Time Zone* Allows the user to view an additional time zone 
in the Time Bar, as well as change time zones.  
This is helpful for travelers or conference calls 
between different time zones.  Also allows user 
to perform a time zone swap and set whether 
DST is observed. 

 

4.  Choose the desired options and click OK to accept. 

5.  Click OK to close the Options dialog box. 
 

 
Tip: 

•  The options marked with an asterisk (*) have further information and 
procedures in this chapter. 
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Setting the Planning Grid Options 

As described in previous chapters, meetings and group schedules use an 
improved planning grid for viewing other users’ calendars and coordinating 
meetings.  The following options control how much information is 
displayed in the planning grid.  These options will only display information 
if at least read permission has been granted to the user for that calendar. 
 

 
Procedure: 

1.  In the Calendar Options dialog box, click Planner Options.  The 
Planner Options dialog box displays: 

 

 

2.  In the Meeting Planner and Group Schedule sections, select or clear 
the following check boxes: 

 

Option Description 

Show popup calendar details Displays a popup box over the selected item in 
the calendar grid with details of the item. 

Show calendar details in the 
grid 

Displays details of appointments and meetings 
in the planning grid instead of solid bars.  Can 
also be controlled on an individual basis by the 
Options down-down menu in the Meeting 
Planner window. 
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3.  Click OK to confirm the changes and close each dialog box when 
completed. 

 

 

Planning grid with both options enabled. 

 

 

Planning grid with both options disabled. 
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Adding Holidays as Events 

Outlook has the ability to automatically add holidays to the calendar as 
events.  Using this feature holidays are scheduled as single-occurring 
events, not annually recurring events. 
 

 
Procedure: 

1.  In the Calendar Options dialog box, click Add Holidays.  The Add 
Holidays to Calendar dialog box displays: 

 

 

2.  Select the check boxes of the countries whose holidays should be 
added. 

3.  Click OK.  Outlook adds the holidays to the calendar.  
 

 
Warning: 

•  The holiday list that is part of Outlook XP only contains holidays through 
the end of 2005.  In order to use this feature to add holidays for 2006 
and beyond, an update must be downloaded from Microsoft.  Check 
Microsoft’s support website – http://support.microsoft.com - for more 
information. 

•  This process only needs to be done once.  If repeated, the holidays will 
be added again to all dates. 
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Setting Free and Busy Options 

The following options control how many months of a user’s calendar is 
made publicly available for scheduling meetings, and how often calendar 
information is updated with the server. 
 
This is not the same as granting read permission to a calendar.  Any user 
can view other users’ calendars to see if they are available for meetings, 
however, they will not be able to see any details or specifics of 
appointments or meetings unless read permission has been granted. 
 

 
Procedure: 

1.  In the Calendar Options dialog box, click Free/Busy Options.  The 
Free/Busy Options dialog box displays: 

 

 

2.  In the Publish box, type the number of months of information that 
should be available to other users in the planning grid. 

3.  In the Update box, type how often calendar information should be 
updated with the server.  

4.  Click OK to confirm the changes and close each dialog box when 
completed. 
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Tip: 

•  To have no information available on the server, enter 0 (zero) months in 
the Publish box.  However, this is not recommended, as it will make it 
impossible for others to view your availability. 

 

 
Warning: 

•  It is not recommended to change the Update setting beyond the range 
of 10 to 30 minutes.  Setting too low of a value will cause increased 
network traffic.  Setting too high of a value will cause other users to see 
outdated information. 

•  The Microsoft Office Internet Free/Busy Service is no longer 
supported by Microsoft.   Visit Microsoft’s support website for more 
information on alternative methods of sharing this information with non-
local users. 
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Processing Meeting Requests Automatically 

The Inbox and Calendar can be configured to automatically handle 
meeting requests as they are received.  These options are ideal for 
resource calendars such as conference rooms, but can be enabled by any 
user to help manage meeting requests. 
 
Additionally, a user can control what happens to a meeting request in the 
Inbox once it is processed. 
 

 
Procedure: (To set automatic processing) 

1.  In the Calendar Options dialog box, click Resource Scheduling.  The 
Resource Scheduling dialog box displays: 

 

 

2.  Select or clear the Automatically accept meeting requests and 
process cancellations check box.  If selected, the following two check 
boxes will be enabled.  Select or clear these check boxes as desired. 

3.  Click OK to confirm the changes and close each dialog box when 
completed. 

 

 
Tip: 

•  The Set Permissions option is not needed in a network environment. 
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Procedure: (To change how meeting requests are handled in the 
Inbox) 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays. 

2.  Click E-mail Options.  The E-mail Options window displays. 

3.  Click Advanced E-mail Options.  The Advanced E-mail Options 
window displays: 

 

 

4.  In the When sending a message section, select or clear the Delete 
meeting request from Inbox when responding check box.  Selecting 
this check box will cause meeting requests to be deleted automatically 
once they have been responded to.  Clearing the check box will keep 
the meeting request e-mail in the Inbox until it is deleted by the user. 

5.  Click OK to confirm the changes and close each dialog box when 
completed. 

 



Chapter 9 – Customizing the Calendar 

© 0A316  Page 183 

Setting Time Zone Options 

Outlook offers a great deal of flexibility when it comes to time zones on the 
calendar.  Time zones can be changed easily, as well as a second time 
zone can be added to the calendar.   
 
For instance, a project manager who deals with a consultant in a different 
time zone would be able to quickly reference the calendar with both time 
zones to simplify scheduling.  
 

 
Procedure: 

1.  In the Calendar Options dialog box, click Time Zone.  The Time Zone 
dialog box displays: 

 

 

2.  Use the following table to select and set options: 
 



Chapter 9 – Customizing the Calendar 

Page 184  © 0A316 

Option Description 

Label Type a text label for the selected time zone.  
This can be the time zone abbreviation such as 
EST or PST,  or it can be a description, such as 
“Manager” or “Consultant”.  It should be kept 
short as the Time Bar can only display a limited 
number of characters. 

Time Zone Use this drop-down list to select a time zone. 

Adjust for daylight saving time Select or clear this check box to indicate 
whether daylight saving time is observed within 
the selected time zone. 

Current time  This is the current date and time as determined 
by the workstation.  It cannot be changed in this 
dialog box.  Use the clock icon in the Windows 
system tray, or the Date and Time icon in the 
Windows Control Panel to make changes. 

Show an additional time zone Select this check box to enable the display of a 
second time zone and set its options. 

Swap Time Zones If two time zones are enabled, this option will 
swap their positions on the Time Bar as well as 
swap their positions in the dialog box. 

 

3.  Click OK to confirm the changes and close each dialog box when 
completed. 
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Calendar with two time zones displayed. 
 

 
Warning: 

•  Changing the first time zone has the same effect as changing the time 
zone in the Date and Time icon in the Windows Control Panel. 

•  When changing the time zone, the time of appointments and meetings 
adjusts as well.  Appointments will stay at their scheduled time in the 
original time zone but will move to the appropriate time in the new time 
zone.  For example, an appointment scheduled for 10:00 a.m. in the 
GMT-5 time zone (Eastern Standard Time) will move to 9:00 a.m. if the 
time zone is changed to GMT-6 (Central Standard Time).  Appointments 
are scheduled in absolute time by Outlook, regardless of the time zone.  
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Changing the Date Navigator Font 

The Date Navigator, located in the upper-right corner of most calendar-
based views, allows easy selection of any date in the calendar.  One of 
the options that can be changed for the Date Navigator is the font and font 
size that are used in the display. 
 
The option for how dates with items appear in the Date Navigator are 
discussed in the view options topic later in this chapter. 
 

 
Procedure: 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays. 

2.  Select the Other tab. 

3.  Click Advanced Options.  The Advanced Options dialog box displays: 

 

 

4.  In the Appearance options section, next to Date Navigator, click Font.  
The Font dialog box displays: 
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5.  Use the Font, Font style, and Size lists to select a new font.  The 
Sample area displays how the selected options will appear. 

6.  Click OK to confirm the changes and close each dialog box when 
completed. 

 

 
Tip: 

•  The Date Navigator font should be kept relatively small (less than 12 
points).  Larger fonts will make it more difficult to display several months 
at a time and take up valuable Outlook interface space. 
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Making Calendar the Default Outlook Folder 

By default, Outlook is configured so that the Inbox is the first folder 
displayed when the program is started.  However, this setting can be 
changed so that the Calendar folder is displayed instead. 
 

 
Procedure: 

1.  Select the Tools menu and choose Options.  The Options dialog box 
displays. 

2.  Select the Other tab. 

3.  Click Advanced Options.  The Advanced Options dialog box displays: 

 

 

4.  From the Startup in this folder drop-down list, select Calendar. 

5.  Click OK to confirm the changes and close each dialog box when 
completed. 
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Modifying a Calendar View 

Views are a powerful feature of Outlook that allow a user to customize 
how and what information is displayed in the calendar, as well as all 
folders of Outlook.  Chapter 1 of this manual explored the built-in views 
that come with calendar, including the calendar-based and table-based 
views. 
 
A complete discussion of creating and customizing views is beyond the 
scope of this course, however, the following procedure and table explores 
the Other Settings view options that can be set by the user when working 
in a calendar-based view (i.e. the Day/Week/Month views). 
 

 
Procedure: 

1.  Select the View menu, choose Current View, then Customize Current 
View.  The View Summary dialog box displays: 

 

 

2.  Click Other Settings.  The Format View dialog box displays: 
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3.  Use the following table to change or set options in this dialog box: 
 

Option Description 

Time Font (Day) Selects the font for the Time Bar 

Font (Day/Week/Month) Selects the font that calendar items will use in 
the selected calendar view. 

Time scale (Day) Use this drop-down to select how much time 
each line/box represents in Day view.  This is 
the same setting as described in the Changing 
the Time Bar topic in Chapter 1. 

Show time as clocks 
(Week/Month) 

If selected for Week or Month views, the start 
and end times of appointments and meetings 
will be displayed as graphical clocks instead of 
text. The start time clock will have a white 
background, and the end time clock will be 
black. 

Show end time (Week/Month) Displays the end time of an appointment or 
meeting in addition to the start time. 
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Option Description 

Compress weekend days 
(Month) 

In Month view, compresses Saturday and 
Sunday into a single box on the right side of the 
calendar to allow more space for weekdays. 

Bolded dates in Date Navigator 
represent days containing items 

Select this option to have dates with calendar 
items with a status (Show time as) of Busy, Out 
of Office, or Tentative appear in bold print in 
the Date Navigator.  Dates with items that are 
marked as Free will not have their dates bolded. 

 

4.  Click OK when complete. 

5.  Click OK again to close the View Summary dialog box and return to the 
calendar. 
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Appendix A 
Toolbars 
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Appointment and Event Toolbar 

This toolbar appears on all appointments and events, including those that 
are recurring.  The title bar of windows with this toolbar will display either 
Appointment, Recurring Appointment, Event, or Recurring Event. 
 

 
 
 

The Meeting Organizer Toolbars 

This toolbar appears when a meeting is being organized.  The title bar of 
this window displays Meeting. 
 

 
 
 
This toolbar appears on a meeting that has already been organized.  The 
title bar of this window displays Meeting. 
 

 
 
 
This toolbar appears on a meeting response e-mail to the organizer.  The 
title bar of this window displays Meeting Response. 
 

 
 
 
This toolbar appears on a meeting response e-mail to the organizer that 
has a new time proposal.  The title bar of this window displays Meeting 
Response. 
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The Meeting Attendee Toolbars 

This toolbar appears when a meeting attendee receives a meeting 
invitation e-mail.  The title bar of this window displays Meeting. 
 

 
 
 
This toolbar appears on a meeting that is in the attendee’s calendar.  The 
title bar of this window displays Meeting. 
 

 
 
 
This toolbar appears on a meeting cancellation notice e-mail.  The title bar 
of this window displays Meeting. 
 

 
 
 
This toolbar appears on the response e-mail an attendee sends to the 
organizer.  The title bar of this window displays Meeting Response. 
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Calendar Item Toolbar Buttons 

The following table lists alphabetically all of the toolbar buttons found on 
the calendar item toolbars as shown in this appendix and a description of 
their function. 
 

Button Name Function 

 Accept Accepts a meeting invitation sent by the 
meeting organizer.  The meeting is 
automatically placed on the calendar. 

 Accept Proposal Accepts the meeting attendee’s new time 
and date proposal for a meeting. 

 Address Book Opens the Outlook address book. 

 Calendar Opens the user’s calendar. 

 Cancel Invitation Converts a meeting window into an 
appointment window when the item is 
being created. 

 Check Names Validates the names in the To field 
against the Global Address List. 

 Copy Copies the selected item to the clipboard. 

 Cut Deletes the selected item from its original 
location and copies it to the clipboard. 

 Decline Declines the meeting invitation sent by 
the meeting organizer.  The meeting is 
not placed on the calendar. 

 Delete Deletes the selected item.  (The item is 
moved to the Deleted Items folder.) 

 Forward Opens an e-mail window allowing the 
user to forward the item to another user. 

 Help Opens the online help system. 
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Button Name Function 

 Importance: High Sets the importance of the item to high. 

 Importance: Low Sets the importance of the item to low. 

 Insert File Allows the user to attach documents to 
the calendar item.  The icons will be 
placed in the message area. 

 Invite Attendees Converts an appointment window into a 
meeting window when the item is being 
created. 

 Move to Folder Opens a submenu to place the item in a 
different Outlook folder. 

 Next Item In a table-style view, opens the next item 
in the list.  In a calendar-style view, opens 
the next item on the currently selected 
day or closes the window if there are no 
other items. 

 Paste Copies the item from the clipboard to the 
currently selected date and time. 

 Previous Item In a table-style view, opens the previous 
item in the list.  In a calendar-style view, 
opens the next item on the currently 
selected day or closes the window if there 
are no other items. 

 Print Creates a hard copy of the currently 
selected item. 

 Propose New Time Allows a meeting attendee to propose a 
different date and/or time for a meeting 
they have been invited to. 

 Recurrence Opens the Recurrence window to set the 
repetition pattern for the item. 
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Button Name Function 

 
Remove from 

Calendar 
Removes the related item from the 
calendar. 

 or  Reply Creates an e-mail reply window. 

 Save Saves the item to the Drafts folder. 

 Save and Close Saves changes to the item and closes the 
item window. 

 Send Sends the item to the chosen recipients. 

 Send Update Sends an update e-mail to meeting 
attendees when changes have been 
made to the meeting. 

 Tentative Provisionally accepts a meeting invitation 
sent by the meeting organizer.  The 
meeting is automatically placed on the 
calendar and marked as Tentative. 

 View All Proposals Opens the Meeting window so that the 
meeting organizer can view all of the new 
time proposals that have been received. 





 

© 0A316  Page 201 

Appendix B 
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The following tables list the symbols and icons that appear in the calendar 
and on calendar-related e-mails. 
 

Icons in Calendar Views 

Symbol Description 

 A meeting. 

 The item is recurring. 

 An exception to recurrence pattern. 

 The item has a reminder set. 

 The item is marked as private. 

 
The start time of an appointment or meeting. 

 
The end time of an appointment or meeting. 

 
 

Icons in Table Views 

Symbol Description 

 An appointment or event. 

 A recurring appointment or event. 

 A meeting. 

 A recurring meeting. 

 
A item with an attachment. 
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Calendar-Related E-Mail Icons 

Symbol Description 

 A meeting request. 

 
An accepted meeting request. 

 
A meeting that has been tentatively accepted or a new time 
proposal for a meeting. 

 
A declined meeting request. 

 
A cancelled meeting notice. 

 
 

Calendar Folder  Icons  

Symbol Description 

 
The shortcut bar calendar icon. 

 The folder list calendar icon. 
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The following is a list of keyboard shortcuts for working in the calendar.  It 
is not a comprehensive list of Outlook keyboard shortcuts, but rather, a list 
of shortcuts that are most relative to working in the calendar. 
 

Action Keyboard Shortcut 

Create an appointment Ctrl+Shift+A 

Create a meeting request Ctrl+Shift+Q 

View from 1 to 9 days Alt+number of days 

View 10 days Alt+0 (zero) 

Switch to weeks Alt+- (hyphen) 

Switch to months Alt+= (equal sign) 

Select next appointment Tab 

Select previous appointment Shift+Tab 

Go to previous day Left arrow 

Go to next day Right arrow 

Go to same day in following week Alt+Down arrow 

Go to same day in previous week  Alt+Up arrow 

Modify length of time in selected block  Shift+arrow 

In Day view, select time that begins work day Home 

In Day view, select time that ends work day End 

In Day view, select previous block of time Up arrow 

In Day view, select next block of time Down arrow 

In Day view, select block of time at top of screen  Page Up  

In Day view, select block of time at bottom of screen Page Down 

In Day view, extend or reduce selected time  Shift+Up or Down arrow  
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Action Keyboard Shortcut 

In Day view, move appointment when cursor is in 
the appointment  

Alt+Up or Down arrow 

In Day view, change appointment start or end time 
when cursor is in the appointment 

Alt+Shift+Up or Down arrow 

In Week or Month views, go to first day of week  Home 

In Week or Month views, go to last day of week  End 

In Week view, go to same day in previous week  Page Up  

In Month view, go to same day 5 weeks previous  Page Up  

In Week view, go to same day in following week Page Down  

In Month view, go to same day 5 weeks in the future Page Down  

In Week or Month views, move appointment up  Alt+Up arrow 

In Week or Month views, move appointment down  Alt+Down arrow 

In Date Navigator, go to first day of current week  Alt+Home  

In Date Navigator, go to last day of current week  Alt+End  

In Date Navigator, go to same day in previous week Alt+Up arrow 

In Date Navigator, go to same day in next week Alt+Down arrow 

In Date Navigator, go to first day of month  Alt+Page Up  

In Date Navigator, go to last day of month  Alt+Page Down  
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